
HP Storage Essentials

Software Version: 6.3

File Servers Guide

Document Release Date: Thursday, June 03, 2010

Software Release Date: June 2010

First Edition



Legal Notices
Warranty

The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying.
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notices

© Copyright 2002-2010 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Microsoft® andWindows® are registered trademarks of Microsoft Corporation.

Oracle is a registered trademark of Oracle Corporation.

UNIX® is a registered trademark of the OpenGroup.

Acknowledgements

This product includes software developed by the Apache Software Foundation
(http://www.apache.org/).

This product includes software developed by the JDOM Project (http://www.jdom.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/).

This product includes software written by Tim Hudson (tjh@cryptsoft.com).

This product includes an interface of the 'zlib' general purpose compression library, which is
Copyright © 1995-2002 Jean-loupGailly andMark Adler.

http://www.apache.org/
http://www.jdom.org/
mailto:eay@cryptsoft.com
http://www.openssl.org/
mailto:tjh@cryptsoft.com


Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID,
go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users – please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at:

This web site provides contact information and details about the products, services, and support that
HP Software offers.

http://www.hp.com/go/hpsoftwaresupport

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient
way to access interactive technical support tools needed tomanage your business. As a valued
support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/hpsoftwaresupport
http://h20229.www2.hp.com/passport-registration.html
http://h20229.www2.hp.com/passport-registration.html


To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

http://h20230.www2.hp.com/new_access_levels.jsp
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20230.www2.hp.com/new_access_levels.jsp


Contents

File Servers Guide 1

Legal Notices 2

Documentation Updates 3

Support 3

Contents 5

1 Overview of File System Viewer 9

Caveats with Using File System Viewer 10

Setting up File System Viewer 10

Working with Scans and Schedules in File System Viewer 11

Adding File Servers for File System Viewer to Scan 13

Deleting VolumeData 13

Scheduling Single andMultiple Scans 14

Adding a Schedule 14

Excluding Volumes from Scanning of File Extension Details 16

Credentials 16

Edit Credentials 18

Scan Now 19

Schedule for Multiple File Servers (Multiple Scans) 20

Warning and Alert for Deleted Volumes 21

Scan Schedules Tab 22

Editing a Scan Schedule 23

Scan Status Tab 25

Performing a Test Scan 26

Importing User Information from LDAP and Active Directory Servers 26

Importing User Information from aDiscovered Exchange Domain Server 27

Importing User Information from LDAP Servers 28

Modifying the Collection Schedule for LDAP Servers 28

Editing Discovery Information of LDAP Servers 29

About Reports for File System Viewer 29



Creating Policies for File System Viewer Users 30

Enable the Scanning of Reparse Points 32

Working with Rules for Gathering File Server Information 33

Add/Remove Volumes 34

Create RuleWizard 35

Edit Rule 37

Create Rule (for Directories) 38

Edit Rule (for Directories) 39

Duplicate Files 40

Add Rule (for Duplicate Files) 40

Edit Rule (for Duplicate Files) 41

Deleting Rules 42

Viewing Results in Report Tree 43

Enabling the Collection of Access Control Entry Data Collection for Directories onWindows
Servers 43

About the FileSRMProvider.properties File 45

Defining UNC Volumes 45

2 Viewing File System Information Across the Enterprise 47

Setting a Context 47

Saving a View 48

Dashboard Information for the Enterprise 49

Properties of the File Servers 51

Extension View 52

Providing Expressions for the Filter Fields 52

Viewing Extension Groups 53

Creating Extension Groups 53

Editing Extension Groups 54

Deleting Extension Groups 54

Aging View for the Enterprise Context 54

Sizes View for the Enterprise Context 55

Managing Users on a File Server 57



Properties of Users 57

Viewing Details for a File System Viewer User 58

Adding File System Viewer Users 58

Modifying File System Viewer Users 59

Deleting File System Viewer Users 60

Exporting a List of Users 61

Modifying a List of Users 61

Viewing Detailed Information for a User 63

Importing a List of Users 64

Policies for a User 64

Adding Policies 65

Editing Policies 66

Testing Policies 67

Deleting Policies 67

Viewing Security and User Identifiers for All File Servers 67

Viewing Detailed Information About anOwner 68

Enabling the Ownership Tab onWindows 69

Trustee View 69

Viewing Detailed Trustee Data 70

How Data is Calculated in the Trustee View 71

Scan Status 72

Scan Schedule 72

Viewing Attribute Details 73

3 Individual File Server Details 75

Dashboard Information for a File Server 75

Properties for a File Server 77

Finding VolumeDetails 78

Types of Files on a File Server 79

Aging Properties of Files on a File Server 82

Size Group Distribution Information 83

Users for a File Server 84



Ownership Information for a File Server 85

Trustee Information for a File Server 86

Events for a File Server 86

Setting up a Filter 86

Selecting a Custom Time Period 89

Resetting a Filter 91

Setting up Advanced Filtering 91

Clearing Advance Filtering Options 93

Viewing Event Details 93

Sorting Events 94

Topology for a File Server 94

Scan Status for File Servers 95

Scan Schedule for File Servers 96

4 Individual Volume Details 97

Dashboard Information for a Volume 97

Properties for a Volume 99

File System Details for a Volume 100

Extensions on Volumes 102

Extensions at the File Level 103

Aging Information for a Volume 103

Aging Properties for Individual Files 104

File Sizes on a Volume 105

Individual File Sizes 105

Users on a Volume 106

Ownership Information for a Volume 107

Trustee Information for a Volume 107

Scan Status for Volumes 108

The Explorer View 108

Directory Dashboard Details on a Volume 109

Index 113



1 Overview of File System Viewer
File System Viewer helps you to understand if your file storage infrastructure is growing in a
managed, organized, and efficient manner. File System Viewer creates an information store about
your storage system.

By combining file, logical, and physical storage resourcemonitoring and reporting with active SAN
management, File System Viewer provides a single integrated system for managing your entire file
storage infrastructure.

Use File System Viewer to obtained detailed information about file servers and volumes across your
network. File System Viewer can provide summary information about your files from across your
enterprise to a specific file server or volume.

File System Viewer can help you with answering the following questions:

l Overall View –Dashboard

n How do I obtain an overview of the following statistics?

n Top five file servers by scanned space

n Top 10 file extensions by size or count

n Top five file extensions

n Accessed age distribution by usage or count

The usage is the total size of all the files with the particular extension.

The count is the number of files with the particular extension.

l Composition –Aging, Size

n Why are there files on a system that have not been accessed for more than six months?

n What is the size group distribution on various file systems?

n Dowe need hierarchical storagemanagement or a store and delete policy?

l Content –Extensions

n Are file systems being used properly?

n Is theremisuse of storage space?

n If there is, then who are the offenders?

l Consumer –Users, Ownership, Applications

n Who is using how much space?

n Is the usage planned?

l Capacity –Used and Available

n What is the total available capacity?
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Chapter 1

n How much is being used?

File System Viewer does a recursive lookup on the file system and stores the information in an
embedded database. File System Viewer can scan files very quickly because File System Viewer
never opens the files.

You can use UNC shares to discover file system data from a server. If you want to scan UNC
volumes, youmust define them in aUncShares.xml file. For details, see Defining UNC Volumes on
page 51.

Caveats with Using File System Viewer
Keep inmind the following when using File System Viewer:

l Themaximum number of threads File System Viewer can use is 15.

l If you do not see information for the file server, verify that the collector for the file server is
running. You can verify that the collector is running by selectingConfiguration > File System
Viewer. On the Scan Schedule tab, look in the Running? column. SeeWorking with Scans and
Schedules in File System Viewer on the facing page.

l File System Viewer is able to detect duplicate files only within a storage volume. File System
Viewer cannot detect duplicate files that exist on different volumes. For example, if you have a
duplicate file on two different storage volumes, File System Viewer will not be able to detect the
duplicate file.

l If you plan to have File System Viewer scan a host, make sure you have 80-120MB for each set
of 1million files. The actual size is dependent on the length of the file names.

l If you want to use File System Viewer bulk import capability for non-ASCII characters (such as
Chinese, Japanese, or Korean), the file should be created with UTF-8 encoding. Notepad, among
other tools, lets you specify the encoding in its “Save As” dialog.

l Reparse points (junctions) for file servers onMicrosoft Windows are scanned. For example,
assume you create a junction namedC:\DDrive, which points to the root of the D drive. The
content of the D drive is available under C:\DDrive. After a scan, information on capacity and
amount used are displayed for the C drive; however, the sum of the file sizes on the C drive also
includes the junction (C:\DDrive), which points to the root of the D drive. If you do not want to
include the scanning of reparse points, see Enable the Scanning of Reparse Points on page 32.
Reparse points created using theWindows Disk Management tool are discovered as a drive that
can be scanned independently.

l A storage volume on amember node that is shared as a cluster resource will not bemanaged
through themember node. It will be available only from the cluster. The File System Viewer
scheduler user interface does not list cluster shared volumes of amember node.

Setting up File System Viewer
Before you can obtain information your file servers and volumes, youmust perform the following
steps:
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1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

1. Discover the host as described in “Step 1 – Discovering Your Hosts and BackupManager Hosts”
in the installation or user guide.

2. Make File System Viewer aware of the file servers it needs to scan, as described in Adding File
Servers for File System Viewer to Scan on page 13. Then, scan the file servers.

You will not see data in File System Viewer until you complete this step.

3. Create schedules for scans, as described inWorking with Scans and Schedules in File System
Viewer below.

4. Import user information as described in Importing User Information from LDAP and Active
Directory Servers on page 26.

5. Create rules for gathering file server information, as described inWorking with Rules for
Gathering File Server Information on page 33.

6. Enabling the collection of ACL data, as described in Enabling the Collection of Access Control
Entry Data Collection for Directories onWindows Servers on page 43.

You will not see data in the Trustee view until you complete this step.

Working with Scans and Schedules in File System Viewer
The File System Viewer simplifies the process of specifying file servers for scan schedules and for
working with the scan schedules. The following shows the File System Viewermain page, with a
representative list of file servers displayed.

Figure 1 File System Viewer – File Servers Tab

The File Servers tab also displays a List of file servers, from which you can choose a specific server.
You can select the following actions in the associated pull-downmenus: Select, Add Schedule,
Credentials, Scan Now, and Stop Scan. These are described further in the following paragraphs.

The screen lets you filter by operating system, or file server name, or both. The screen contains these
three buttons located across the upper part of the page:

l Add File Server – Adds a file server.
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l Schedule Multiple File Servers –Opens a wizard to schedulemore than one file server at a
time.

l Delete – This button at the upper corner of the page allows you to delete more than one file server
at a time. A user first selects the file servers to be deleted, and then selects this Delete button. A
confirmation page appears before the deletion occurs.

The screen displays a list of file servers and indicates the name, the operating system and version,
and whether a file server is part of a cluster. Associated pull-downmenus (in the Action column) let
you select the following actions for selected file servers:

l Add Schedule –Opens the Add Schedule wizard to enable the addition of a new File Server
Viewer schedule. Only one schedule can be added for file servers on hosts with agents prior to
6.0.

l Credentials – Starts a wizard for you to specify the credentials to be used for scan volumes on
the file server. This functionality is supported for CIFS shares in case of Windows file servers
and all types of volumes for UNIX file servers that are supported by File Server Viewer.

l Scan Now – Allows user to perform a “run once” scan on a selected set of volumes on a
specified file server immediately. Selecting Scan Now opens a wizard where you can select a set
of volumes to scan immediately.

l Stop Scan – Stops all the File Server Viewer scans currently running on the file server. This
stops all scans running globally on the file server at themoment, but it does not stop the
schedule.

l Test Scan – Enables you to preform the Test Scan functionality. The feature is not available for
file servers on virtual cluster hosts. See Performing a Test Scan on page 26.

l Delete File Server (icon) – Deletes the File Server Application that was created on the host. It
deletes all File Server Viewer information collected on the file server.

Other tabs on the File System Viewermain screen include the Scan Schedule tab, the Scan Status
tab, and the Reports Rules tabs:

The Scan Schedule tab displays the screen used to setup and associate scan schedules to a
selected file server. Functions available at the Scan Schedule screen include the Start and Stop scan
buttons, Edit the schedule, and Delete (for individual file server schedule deletion and for deleting all
the selected file server schedules). The Scan Schedule tab page is described inmore detail later in
this section of the guide.

The Scan Status tab provides information about the status of themost recent scan on each of the
configured volumes.

The Report Rules tab was described previously in this chapter, and displays the screen used to set
up the rules for creating reports for specific needs.

The following paragraphs describe the process of setting up and working with scan schedules.
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1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

Adding File Servers for File System Viewer to Scan
Youmust make File System Viewer aware of file servers it needs to scan in order to see information
from your file servers.

Keep inmind the following:

l File System Viewer does not scan the volumes with file system of type “GPFS” on HACMP
clusters.

l Cluster shared resources on file server member nodes are not displayed on the Topology tab.

To add file servers for File System Viewer to scan:

1. Click Add File Server on the File System Viewermain page (Configuration > File System
Viewer).

The Add File Server button displays a list of available file servers that support File System
Viewer (data collectionmust be enabled on these file servers).

2. From the displayed list of available file servers, add file servers by selecting the check boxes for
the file servers and clickingOK.

File servers that are part of a host cluster aremarked accordingly in the Is Cluster column of the
list.

Deleting Volume Data
You can delete the file system specific data of a scanned volumes, so that the volumewould be
similar to an unscanned volume. The volumewould also be removed from the scan schedule and any
report rule mappings. If all volumes in a schedule are deleted, the schedule is also deleted.

Data from volumes currently being scanned would not be deleted. You can tell if a volume is currently
being scanned because it will have a scan status of one of the following:

l Scan started

l Scan in progress

l Transferring

l File uploading

The volumewith symbol (#) denotes that the volumewas scanned before assigning it as a cluster
volume through the Build Cluster. This volume data shall be removed since it will not be shown in any
of the FSV page.

To delete volume data:

1. Click Configuration > File System Viewer.

2. Click the File Servers tab.

3. Click Delete Volume data.

4. Click theShow Available Volumes link if the volumes are not displayed.
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5. Click theShow Filter link if the filter is not displayed.

6. In the Select OS field, select the operating system for the file server or select all to display all file
servers.

The file servers meeting the criteria of the Select OS field are displayed in the Select File Server
window.

7. In the Select File Server window, select a file server.

The name of the file server is displayed in the File Server Name field.

8. Click Go.

HP Storage Essentials displays the volumes on the selected file server in the pane below.

9. Select the volumes you want to delete, and click Add Selected Volumes to Delete Data.

The selected volumes are displayed in the Selected Volumes table. Volumes that are in the
Selected Volumes table are reverted to the status of an unscanned volumewhen the Finish
button is clicked.

10. To remove a volume from the Selected Volumes table, select the volume and click Remove
Selected Volumes form Deleting Data.

11. Click Finish.

Volumes in the Selected Volumes table are reverted to the status of an unscanned volume.

Scheduling Single and Multiple Scans
You can create single scan andmultiple scan schedules for a file server. Themultiple scan schedule
feature lets you schedule scans of different volumes at different intervals and at different start times.
However, you can add only one schedule for file servers on hosts with agents prior to 6.0.

To begin configuring for single or multiple scans, youmust first declare the intended host a file server,
and then you use the Add Schedules wizard to create the schedules for the intended file server.

Adding a Schedule
On the File System ViewerMain page (File Servers tab), locate the file server on which you want to
setup the scan schedule.

To add a schedule, follow these steps:

1. Select Add Schedule from the pull-downmenu choices (in the Action column).

2. Select theCreate Schedule wizard, which opens and displays a screen similar to the following:
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1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

Figure 2 Add (Create) Schedule

The wizard contains two volume lists.

l Available Volumes – This table shows volumes that are available for scheduling

l Selected Volumes – This table shows volumes selected for scan.

The lower part of the display contains scan schedule information (start date and time, interval for the
scan). The display also shows the number of threads, representing the number of parallel scans to be
performed for this schedule. Minimum value for the field is 1. Start time cannot be earlier than the
current time, and thread count cannot bemore than the number of volumes.

Volumes can be selected for inclusion in a schedule by selecting corresponding check boxes and
clicking theAdd button. This removes the selected volumes from the Available Volumes table and
adds them to the Selected Volumes table.

You can correct inadvertent selections by clicking theDelete button below the selected volumes
table. This moves the corresponding volumes from the Selected Volumes table to the Available
Volumes table.
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Each volume can be individually configured. The options for each volume in the Selected Volumes
table are:

l Volume specific exclude directory list. The default exclude directory list is based on value of
JBOSS property “fileSrm.excludeDirectories”.

Note: Scanning of a directory mentioned in the exclude directory list will be skipping collections if
the directory exists in the root of the volume. If a directory of the same name exists at any other
level, then that directory will be scanned.

l Option to collect ownership. For UNIX file servers, the default is true. ForWindows file servers, it
is based on the property “fileSrm.collectWindowsSID,” which is available from the Show Default
Properties window (Configuration > Product Health > Advanced > Default Properties).

l Option tomap users to ownership. The option is enabled only if the ownership collection is
selected.

l Option to collect ACL information forWindows file server. By default, this option is disabled. You
can enable this by setting the “fileSrm.collectACL” property to true.

The properties specified above are to help a user in the Add Schedule wizard. Once the schedule is
saved, any changes to the properties will not affect already saved schedules. All schedules can be
viewed and edited in the Scan Schedules page.

Excluding Volumes from Scanning of File Extension Details
If you have volumes with more than twomillion files, youmay want to decrease the scanning time by
excluding volumes with many files from the scan.

File extension details are not collected for the volumes specified in the
fileSrm.volumesToSkipExtensionsGathering property; for example:

fileSrm.volumesToSkipExtensionsGathering=10000,10001

In this instance, 10000 and 10001 are volume IDs for the volumes that are designated to be excluded.
The property can be found inConfiguration > Product Health > Advanced > Default Properties.
Refer to the online help for the Default properties page for more information on how to change a
property.

Note: Skipping collection of file extensions could impact the way file extensions are displayed
in the drill-downmenus of the product. The information displayed for the file extensions on
excluded volumes could bemissing or outdated.

Credentials
You can specify or edit the credentials used by the File Server Viewer to scan volumes on the File
Server Viewer. To assign or clear credentials, select Credentials from the pull-downmenu choices
(in Action column). The wizard opens a display similar to the following:
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1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

Figure 3 Credentials Wizard

The screen lets you assign credentials, clear credentials, and edit credentials. To assign credentials
to a given set of volumes, choose the volume and select theAssign Credentials button.

Note: You can edit or clear credentials for a UNC share volume using the Credentials wizard.
However, onWindows-based systems, doing so does not prevent running further successful
scans on the volume. This is becauseWindows allows you to run a successful scan on that
volume, even though the credentials for it were edited or cleared.

A display similar to the following opens to let you assign (specify) the user name and password to use
for scanning the volume.
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Figure 4 Assign Credentials

In the display, specify the user name and password, and then select OK. The credentials are saved
into the database after the wizard completes.

Edit Credentials
If you chose Edit Credentials from the wizard shown previously, the following screen displays to
allow you to change a user name and password previously assigned.

Figure 5 Edit Credentials

The associated volume is shown in the header. Enter the new credentials and then select OK.
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1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

Scan Now
Select theScan Now pull-downmenu choice (Action column) to perform an immediate scan on a
given set of volumes. The wizard and functionality are similar to configuring an interval-based scan,
except that the start time and interval are not required. See the following figure showing a
representative Scan Now display.

Figure 6 Scan Now

The “@” symbol appended to the drive name indicates that the volume is scheduled for a scan in an
interval schedule. The “Thread Count” feature allows you to specify the number of parallel scans to be
run in the schedule.

Note: The Scan Now option creates a “run once” schedule, and that the schedule information
is not stored for future use. Exercise caution when using the Scan Now option, because a
scheduled scanmight be already in-process at the instant a forced scan is invoked. In these
situations, the volumes currently being scanned, or the volumes currently in the scan queue,
will be omitted from the new scan request.
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Schedule for Multiple File Servers (Multiple Scans)
The ScheduleMultiple File Servers button on themain FSRM display page, File Servers tab, was
shown previously and provides functionality similar to the Add Schedule button. It also provides the
additional capability to createmultiple schedules across multiple file servers. Selecting the button
starts a wizard which contains two tabs, Available Volumes and Selected Volumes.

The following representative screen shows the Available Volumes display.

Figure 7 Schedule Multiple File Servers (Available Volumes Tab)

The filter lets you narrow the list of file servers displayed. After filtering, the File Servers list shows
the list of file servers available for scheduling. Use the corresponding radio buttons to populate the list
of volumes available for scheduling (Storage Volumes table).

Multiple volumes can be selected and configured from the table to be added in the schedule. After the
configuration is finished, select theAdd button to confirm the number of volumes selected for the
schedule.
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1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

You can repeat the previous steps for other file servers in the File Servers table, or you can filter new
file servers. After you add the volumes for the file servers, select theNext button to open the
Selected Volumes tab display. The following is a representative display.

Figure 8 Schedule Multiple File Servers (Selected Volumes Tab)

The display shows the volumes added for the various file servers in the Available Volumes tab. The
Selected Volumes tab display does not permit editing volumes. To edit configurations, or remove
volumes, select thePrev button to go back andmake the changes.

The Selected Volumes tab displays the date and time, the interval, and the thread count for the
schedules created. After you assign the required values, select the Finish button to create schedules
for themultiple file servers.

The wizard helps you createmultiple schedules at the same time. Once submitted, schedules are
created for each file server that was configured.

The thread count for the schedule created is computed by the formula:

Thread Count = minimum (Number of Volumes Selected, value in Thread Count field)

Warning and Alert for Deleted Volumes
When you select drives for a particular host, they show as selected (on the Configuration File Viewer
page) for a period of time (one day, 12 hours, etc.). When the drives no longer display as selected
after that period of time, a warning icon appears for those schedules that are partially or fully affected.

When you click the warning icon, an alert message appears. Themessage content depends upon
whether the volumes are partially or fully affected and are described in the following paragraphs.

All volumes affected – Assume a schedule contains five volumes (for example) and are all deleted
in the database. If you click on the warning icon that appears, then an alert message similar to the
following displays:
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Storage volumes scheduled for a scan in this task either do not

exist now, or have changed in the database. These volumes cannot be

scanned now. Please click Delete icon to delete them and create a

new schedule.

Some volumes affected – Assume a schedule contains five volumes and only some of them are
deleted in the database. If you click the warning icon that appears, then an alert message similar to
the following displays:

Some Storage volumes scheduled for a scan in this task either do not

exist now, or have changed in the database. These volumes cannot be

scanned now. Please click on Edit icon to include them for a scan.

Scan Schedules Tab
The Scan Schedules Tab on the File System Viewermain page lists all the schedules created for the
various file servers, as shown in the following representative display.

Figure 9 Edit Schedule (Scan Schedule Tab)

TheStart andStop buttons near themiddle of the screen, at the right, can be used as batch
operations to start or stop the selectedmultiple schedules. TheDelete button can be used as a batch
operation to delete selectedmultiple schedules.

Each schedule lists the file server, volumes selected for scan on the file server, the time the schedule
is invoked next, the interval in minutes, and its status (running or stopped). The display also contains
the following:

l Stop Scan – This button attempts to stop the scan on the volumes selected in the schedule. It
does not stop the schedule and the schedule can run at the next interval. If you want to disable a
schedule, select the Stop button (at the top of the page) after selecting the schedule to be
disabled.

l Delete Schedule icon – Select this icon to delete the schedule. It stops the scan on the
volumes selected for the schedule before the deletion. However, this does not alter any File
Server Viewer data already collected for the volumes in the schedule.

22



1  Overview of File System Viewer-Working with Scans and Schedules in File System Viewer

l Edit icon – This starts the Edit wizard, letting youmodify the schedule to change the volume list
or its other scan options. Edit is described further in the following paragraphs.

Editing a Scan Schedule

The Edit button lets you change the scan configuration by changing the volume list for the scan,
changing the start time (next scheduled time to run if one is already started), interval, and thread
count. You can also change volume specific information, such as ownership collection, mapping
users to ownership, exclude directory list, and ACL collection for theWindows file server.

Clicking the Edit icon starts a wizard. The screen contains two tabs, Available Volumes and Selected
Volumes, as shown in the following representative screen displays.

Figure 10 Scan Schedule Edit (Available Volumes Tab)
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This screen lets you select volumes available for further addition to the schedule by checking the
corresponding check box. You can alsomodify the default configuration information for each volume.
After making your selections, select theAdd button to confirm your intent to add them to the
schedule.

Note: TheAdd button does not add the volumes to the schedule yet; it only confirms they are
considered for addition.

After selecting the Add button, select theNext button to open theSelected Volumes tab. A screen
similar to the following is displayed.

Figure 11 Scan Schedule Edit (Selected Volumes Tab)

This display provides a list of volumes for this schedule. You can remove volumes by selecting the
Remove button.

Note: Theremust be at least one volume in the Selected Volumes tab. You cannot delete the
schedule by simply removing all the volumes from the Select Volumes tab. If you attempt to
delete all the volumes in the Selected Volumes tab, an alert is raised.
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Scan Status Tab
You can review the status of the current scan or themost recent scan that took place on each of the
volumes on which a scan was started. To check the status of a scan:

1. Select Configuration > File System Viewer.

2. Click theScan Status tab.

The following table provides details about theScan Status tab:

Column
Heading

Description

File Server Displays the name of the file server from which this collector gathers
information.

Volume Displays the volume selected for scanning on a file server.

Scan Start Displays the time that the scan began.

Last Polled If the scan is still in progress or failed, it displays the time of the last scan.

Scan End If the scan is completed, displays the completion time.

Scanned Space Displays the total size of the files scanned by File System Viewer.

No. Of Files Displays the number of files that have been scanned.

Current Directory Displays the directory that is currently being scanned.

Scan Status The following scan statuses are possible:

No Data

Scan in Progress

Scan Done

Scan Failed

Transferring Data

Transfer Completed

Uploading Data

Uploading Completed

Error

Table 1 About File System Viewer Scan Status
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Performing a Test Scan
If you have changed your network configuration, and you are not sure themanagement server can still
scan the server running File System Viewer, you can perform a test File System Viewer scan. During
this scan, themanagement server verifies that it can access the server and perform a high-level File
System Viewer scan. It also verifies whether or not it can scan network volumes with host discovery
credentials.

Keep inmind the following:

l This feature only works with CIM extensions version 5.1 and later.

l If you want to scan network-mounted drives on a host runningWindows, youmust make sure a
user is logged onto theWindows host. The user must have permission tomount the network
drives. Network drives mounted onWindows 2000 hosts are not visible as storage volumes on
the Navigation tab or in the topology.

To perform a test File System Viewer scan:

1. Select Configuration > File System Viewer.

2. Verify that the File Servers tab is selected, and then click Test in the Test Scan column of the
File Servers table.

After you click the Test button, themanagement server attempts to access the server and
perform a test File System Viewer scan.

Importing User Information from LDAP and Active
Directory Servers
You can enable the automatic population of user details from Active Directory and/or Light weight
direct access protocol (LDAP) servers, so at least the following information is retrieved from directory
services:

l User Name

l Full Name

l Email ID

l Department Number

l User Quota

l *User Status, for example: Active or Disable

l *Manager

l HomeDirectory

l Owner
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*The User Status andManager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

HP Storage Essentials lets you import user data from two types of servers:

l Exchange servers – If you have already discovered Exchange servers, you can select the
servers from which you HP Storage Essentials to import user data, as described in Importing
User Information from aDiscovered Exchange Domain Server below. Exchange servers are
considered as LDAP servers in the LDAP Users Collection table.

l LDAP servers – Discover LDAP servers from which you want HP Storage Essentials to import
user data, as described in Importing User Information from LDAP Servers on next page.

You can specify how often user information from the servers listed in the LDAP Users Collection
table is updated, as specified in theModifying the Collection Schedule for LDAP Servers on page 31.

About the LDAP Users Collection Table

The LDAP Users Collection table lists the servers that have been designated to be scanned by HP
Storage Essentials for user data.

The LDAP Users Collection table provides the following information about an LDAP server:

l Domain – The domain in which the LDAP server resides.

l Domain controller name – The name of the controller name for the LDAP server.

l Next Scheduled Run –WhenHP Storage Essentials will scan the LDAP server again for
updated user information.

l Interval in Minutes – How often the scan is scheduled to run.

l Enabled – A check mark is displayed if collectors are running. Collectors must be running for a
scan to run.

l Collection status – Lets you know if a scan is currently taking place or if the scan is complete

You can also do the following from the LDAP Users Collection table:

l Edit discovery information for an LDAP server, as described in Editing Discovery Information of
LDAP Servers on page 29.

l Edit the scan schedule for an LDAP server, as described inModifying the Collection Schedule for
LDAP Servers on next page.

l Delete an LDAP server from the table. When an LDAP server is deleted from the table, HP
Storage Essentials no longer scans the LDAP server for user information.

Importing User Information from a Discovered Exchange Domain Server
To import user data from a previously discovered Exchange Domain Server, follow these steps:

1. Select Configure > File System Viewer > LDAP Servers and then click Add Active
Directory Domain Controller(s).
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2. Select the discovered Exchange Domain Server that contans the user data you want to appear in
HP Storage Essentials.

3. Click Add, and then click OK.

The Exchange Domain server is designated as an LDAP server.

Importing User Information from LDAP Servers
To import user data from LDAP servers, follow these steps:

1. Select Configure > File System Viewer > LDAP Servers and then click Add LDAP Servers.

2. Expand the link, Add New LDAP Server.

3. Select the discovered LDAP that contans the user data you want to appear in HP Storage
Essentials.

4. Provide the name of the domain in the Domain field.

5. Provide the name of the domain controller in the Domain Controller Name field.

6. Provide user name in the User Name field.

Note: The user name can be the common name (CN) of the user or theWindows login name.
You can find the CN from the Active Directory Users and Computers plug-in. The user must
possess aminimum of “Domain Users” privileges.

7. Provide the password for the User name in the Domain Password field.

8. Provide the password again in the Verify Password field.

9. Click Add, and then click OK.

The product imports user data from the LDAP server.

Modifying the Collection Schedule for LDAP Servers
Tomodify how often user information is gathered an LDAP server, follow these steps:

1. Select Configure > File System Viewer > LDAP Servers.

2. Select the LDAP server for which you want to modify the schedule.

3. Click theEdit Schedule ( ) button.

4. Click the calendar icon, .

5. In the Time box, enter the time in 24-hour format with the hour andminutes separate by a colon,
for example, 22:15. Click the date on which you want the task to run. Today’s date is highlighted
in pink. Click Set.

The date and time appear in the Next Scheduled Run box in the yyyy-mm-dd hh:min format.
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If you change the date in the box to a date that does not exist in amonth, the software
automatically calculates the date to the next month. For example, if you enter 2003-11-31, the
software assumes the date is 2003-12-01.

6. In the Interval box, enter an interval. Select one of the following units from the list:

n Second(s)

n Minute(s)

n Hour(s)

n Day(s)

n Week(s)

7. Click OK.

Editing Discovery Information of LDAP Servers
To edit discovery of LDAP servers, follow these steps:

1. Select Configure > File System Viewer > LDAP Servers.

2. Select the LDAP server you want to edit, then its correspondingEdit ( ) button.

3. Modify the user name and/or password.

4. Click OK, and then click OK again.

The product imports user data from the LDAP server.

About Reports for File System Viewer
Report Optimizer provides a variety of detailed reports for file servers.

Data collectors gather information for reports. If you stop a data collector, its reports are not updated.
Youmight want to verify that a collector is running if you are having difficulty viewing a report or you
believe the report is not displaying the latest information. See the user guide for more information.

In addition, you can configure File Server SRM to gather specific information based upon user-defined
rules for gathering the information, through the capability to add rules, delete rules, edit rules, andmap
volumes to the rules. This is described inmore detail later in this guide.

Also, you can createmultiple schedules for a single file server. You can add volumes to schedules,
and can remove them from schedules. A schedule cannot contain volumes (details) for more than one
file server; however, each file server may havemore than one schedule.

After a successful file server scan, the upload process starts. During this time, details (extensions,
aging and size groups, and so on) are collected. After that, the File Server SRM custom report data
collection begins.

The first part of the process enumerates all rules for the given volume; the process then executes
according to the rules specified.
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The reporter reads the results, to display the information according to the display criteria specified.

Themanagement server provides reports that display performance information in a variety of formats:

l HTML (default) – The software displays the report in aWeb page by default.

l PDF – The software displays the report in Adobe Acrobat, a good option if you need to print the
report. The software assumes you already have Adobe Acrobat Reader installed on your
computer. To obtain a copy of Adobe Acrobat Reader, go to the following URL:
http://www.adobe.com.

l Excel – The software displays the report in Microsoft Excel, providing you have a copy of
Microsoft Excel already installed.

l XML – The software displays the report in the XML format.

Examples of reports include those that list files not accessed in the past n years, files with specific
file extensions and that exceed a given size, etc. For example, File Server SRM can group the file
extensions into different categories, so that users can generate reports for the different applications,
such as office-related files (*.doc, *.ppt, *.xls) or music-related files (*.mp3, *.avi). Supported reports
can be used by external reporting tools.

Report information can be filtered. UNIX Global Permissions allows users to filter files into the report
based on the selection of rwx permissions. Files with other permissions will be present in the report if
they satisfy the selection. For example, the report corresponding to global write permission alsomay
contain files with global execute permission, provided the files also have the global write permission.

TheWindows Attributes option allows users to filter files into the report based on the selected set of
attributes. Only the files that have the selected attributes will be collected against the rule
(irrespective of the state of the other attributes). For example, selecting Archive and Encrypted
attributes will filter all files that have these attributes; some of the files in the report may contain files
of other attributes (that is, Hidden), if they have the archive and encrypted attributes.

Note: Non-ANSI text—for example Asian characters and the Euro symbol—included in a
comma-separated values file is not displayed properly by Microsoft Excel. Excel replaces the
non-ANSI text with a questionmark (?).

Creating Policies for File System Viewer Users
You can create a utilization policy that generates an event, sends an email, or runs a custom
commandwhen an element is being overused. For example, you can configure Policy Manager so
you receive an email message when the amount of free space on a server decreases to a specified
level.

Note: If you plan to use email notification with your policy, first assign an SMTP server from
which themanagement server can send its email notifications.

To create a utilization policy for a file server:

1. Access Policy Manager by clicking the Policy Manager icon in the left pane.

2. Expand the Policy Manager tree so it displays File Server Users and the users beneath the node.

3. Do one of the following:
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l If you want the policy to apply to all File System Viewer users, select the File Server Users
node.

Or

l If you want the policy to apply to only one of the File System Viewer users, select the user
you want the policy to apply.

4. In the right pane, select Add.

5. Select a policy, and then select Next.

6. In the Name box on the Policy Properties tab, modify the name of the policy or keep the default.

7. In the Description box, modify the description for the policy or keep the default.

8. In the Re-arm Period box, specify a re-arm period in minutes.

The re-arm period is the amount of time after the policy executes before it can execute again. It is
useful for limiting the number of times the same actions will execute.

Note: Specify shorter periods for important applications.

9. To the right of the comparison operator menu, enter a percentage or an amount in gigabytes (GB),
depending on the box name displayed.

10. For trending policies, enter the number of days in the Historic period box
(min=7; max=180) and Projection period box (min=1; max=180).

11. Select an action to occur when the policy condition is fulfilled, by selecting one or more of the
following buttons (more than one action can be assigned to a policy):

l Send E-mail – Policy Manager sends an email when the condition is fulfilled. Enter a
comma-separated list of email addresses, and then select OK.

l Generate Event – Policy Manager generates an event of the specified event type. The event
appears in Event Manager. Select one of the following event types.

Note: Since the severity level for an element is set by themanufacturer, themeanings of the
severity levels vary. It is best to view the description of the event.

n Unknown – The severity level is not known.

n Informational – An example of an informational event is a progress report event for
firmware download operation currently in progress.

n Warning – An example of a warning is when one or more new physical fabric objects
(device port, switch, or fabric) have appeared.

n Minor – An example of aminor event is when a physical fabric object (switch port or
fabric) has changed state.

n Major – An example of amajor event is when one or more physical fabric objects
(device port, switch, or fabric) have disappeared.

31



Chapter 1

n Critical – An example of a critical event is Brocade switches that have a failed firmware
download and the failure reason code for each respective switch.

After you select an event level, select OK.

l Execute a Custom Command – Policy Manager executes a custom command on the
management server when the condition is fulfilled. Enter a command that will execute the
script in the box, and then select OK. The software assumes you are in the [Install_
Dir]\JBossandJetty\server\appiq\remotescripts directory on themanagement server when the
script is executed. You can use environment variables in your script, such as POLICY_
NAME andPOLICY_DESCRIPTION. POLICY_NAME. POLICY_NAME provides the policy
name andPOLICY_DESCRIPTION provides the policy description. See “Software
Environment Variables for Scripting” in the user guide.

Prefix the commandwith start if the custom command triggers a UI component, such as a
program that uses the UI (for example, Microsoft Internet Explorer) or a command prompt
window.

For example, assume you want the custom command to open a command prompt window
and list the contents in the directory. You would prefix the commandwith start:

start dir

12. Select Finish.

13. To test a policy, select the Test button in the Utilization Policy table.

14. For more information about editing, deleting, and emailing policies, see the “Managing Policies”
chapter in the user guide.

Enable the Scanning of Reparse Points
Reparse points (junctions) for file servers onMicrosoft Windows are scanned. For example, assume
you create a junction namedC:\DDrive, which points to the root of the D drive. The content of the D
drive is available under C:\DDrive. After a scan, information on capacity and amount used are
displayed for the C drive; however, the sum of the file sizes on the C drive also includes the junction
(C:\DDrive), which points to the root of the D drive.

To enable the scanning of reparse points onWindows file servers:

1. Select Configuration > Product Health, and then select Advanced in the Disk Space tree.

2. Select Show Default Properties at the bottom of the page.

3. Copy the fileSrm.disableReparsePointsScanproperty. How you copy the text depends on your
Web browser. If you are usingMicrosoft Explorer or Netscape Navigator, select the text, and
then right-click the selected text, and then select Copy.

4. Return to the Advanced page (Configuration > Product Health, and then select Advanced in
the Disk Space tree).
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5. Paste the copied text into the Custom Properties box. How you paste the text depends on your
Web browser. If you are usingMicrosoft Explorer or Netscape Navigator, right-click the box and
select Paste.

6. Change the value assigned to the fileSrm.disableReparsePointsScanproperty to false in the
Custom Properties box.

fileSrm.disableReparsePointsScan=false

7. When you are done, select Save.

8. Restart the AppStorManager service for your changes to take effect.

Working with Rules for Gathering File Server Information
You can create specific rules for the kind of information the system gathers and reports about file
server volumes and directories (rule-based reporting). You do this by adding, deleting, and assigning
rules to selected file server volumes and directories. In addition, you can edit previously created rules
to accommodate changing reporting needs.

The Report Rules tab in the File System Viewer (Configuration > File System Viewer) provides the
user interface and wizards to create andmodify these rules. The following graphic shows a
representative display of the page.

Figure 12 Report Rules Tab

Using the buttons and check boxes on this screen, you have functionality to Add, Delete, and Edit
rules, Add/Remove volumes associated with the rules, Refresh File Server Reports Cache, and
Clear Data.

Data collected for the rules is reflected in reports according to the reports refresh schedule. The
Refresh File Server Cache button refreshes the reports cache immediately with data acquired using
latest rules for gathering the data.

The Clear Data button deletes the data collected against a Rule. Clearing the data for a Rule, then
refreshing the reports cache using the Refresh File Server Reports Cache button also removes the
rule’s earlier data from the reports cache.
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Add/Remove Volumes
The Add/Remove volumes icon starts a wizard that lets youmap volumes to rules (or remove them).
The wizard has two tabs, Available Volumes and Selected Volumes, as shown in the following
representative display.

Figure 13 Available Volumes and Selected Volumes Tabs

From the Available Volumes tab display, use the Filter button to display a list of file servers. Select
the radio buttons to select the volumes from those available for mapping the rules. After making your
selections, click theAdd button to confirm the choices selected. You can repeat the process for other
file servers in the table, or click the Filter button to populate a new list.

Select theNext button to open the Selected Volumes tab, shown in the following representative
display.
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Figure 14 Selected Volumes

This wizard helps youmap volumes onmultiple file servers at the same time. If you need to edit your
selections, select thePrev button. When you are finished, select the Finish button tomap volumes
to a rule, or select theRemove button to remove them from.

Create Rule Wizard
Use the Create Rule wizard to help you create report rules for files. The Create Rules button was
shown earlier in this section, in the Report Rules Tab screen display. The Create Rule wizard opens a
page similar to the following.
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Figure 15 Create Rule Wizard Display

To create rules for files, use the radio buttons to select the files or directories to which the rules will be
applied.

Use the screen to input the following information for the rule:

1. Select corresponding check boxes to include the criteria in the rule

2. Rule name is mandatory

3. Select the appropriate text box before entering value in text box. Otherwise, text box is disabled.

4. All check boxes are unchecked, by default.

5. Description is optional.

6. At least one checkbox should be selected, in addition to RULENAME and Limit Rows.

7. Maximum value should be greater thanminimum value (File Size >=5 and <=4 is invalid.)
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8. In the “Owned by” text field, you can set single user, or multiple users separated by commas.

9. In the “Include directories” text field, you can set single directory, or multiple directories
separated by commas.

10. Enter a value in the “Limit Rows” field, to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule may return a very large number of rows; if no value is entered, then
all data is returned. Limit Rows fetches the Top “n” largest from the total result set.

11. Drop-down choices for sizes shows units for bytes, KB, MB, andGB. Maximum number of digits
allowed is five.

12. Drop-down choices for days shows units for days, weeks, months, and years. Maximum allowed
digits to enter is five, and accepts amaximum of 43,800 days (120 years) only after converting
the units (weeks, months, years) into days.

13. Windows Attributes only affects Windows file servers even though a Report Rule is mapped to a
UNIX-type file server.

14. UNIX Global Permissions only affects UNIX-type servers even though a Report Rule is mapped
toWindows file servers.

15. When you select OK, the rule is created for all the fields whose check boxes are selected. At the
time of information gathering, the associated rules are applied to the gathering process to collect
the data prescribed by the rule, and to store the data in the database.

Edit Rule

Use the Edit wizard to edit rules by modifying the Rule criteria. The Edit wizard icon was shown
earlier in this section, in the Report Rules Tab screen display. When you start the Edit wizard, a
screen similar to the following displays.
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Figure 16 Edit Rule Screen

The input field for the rule name is disabled so that you cannot change the rule name for any report.
Also, the radio buttons for “Apply this rule to” are disabled so the type (files, duplicate files,
directories) cannot be changed.

The preceding “Create Rules” requirements also apply to the “Edit Rule” screen.

Create Rule (for Directories)

The Create Rule (for Directories) wizard helps you create rules for reporting about directories.

Start by selecting theCreate Rule button shown earlier in this section, in the Report Rules Tab
screen display. This opens the Create File Server Report Rule page, where youmust select the
Directories radio button. Selecting the Directories radio button displays a screen similar to the
following.
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Figure 17 Create Rule (for Directories)

The screen then displays the input fields for creating the Rule criteria for Directories. The criteria
includes Last Accessed time interval (days, weeks, months, years) and Last Modified time interval.

Enter the Access and Last Modified Days criteria. Reports will be generated for directories that have
been accessed greater than the Access days value, and greater than the Last Modified days value.

Provide input to the screen according to the following rules:

l Rule name is mandatory

l At least one checkbox should be selected, in addition to the Limit Rows, and the respective input
box should be filled.

l The description is optional.

l Enter a value in the “Limit Rows” field, to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule may return a very large number of rows; if no value is entered, then
all data is returned. Limit Rows fetches the Top “n” largest from the total result set.

l The drop-down for days will show units for days, weeks, months, and years. You can enter a
maximum of 5 digits; input accepts amaximum of 43800 days (120 years) only after converting
the units (weeks, months, years) into days.

l When you select OK, the rule is created for all the fields whose check boxes are selected.

Edit Rule (for Directories)

The following shows a representative screen display for the Edit Rule (for directories) wizard.
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Figure 18 Edit Rule (for Directories)

With the Edit Rule (for Directories) screen, you can change the access andmodified days. The input
field for the rule name is disabled; you cannot change the rule name for any report. Also, the radio
buttons for “Apply this rule to” are disabled so that you cannot change the type (Files, Duplicate Files,
Directories) of the rule. The criteria for the other remaining entries are the same as described
previously for creating a rule for Directories.

Duplicate Files
The system takes various inputs (match file size, matchmodified time stamp and directory) that are
used as criteria to collect the duplicate files, and then generates a rule that you canmap to any
volume across fileservers. When the system gathers information, it applies the rules that exist for the
particular volumes, and then collects the data and stores it in the database.

Add Rule (for Duplicate Files)

Start by selecting theCreate Rule button shown earlier in this section in the Report Rules Tab
screen display. This opens the Create File Server Report Rule page, where youmust select the
Duplicate Files radio button. Selecting the Duplicate Files radio button displays a screen similar to
the following.
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Figure 19 Add Rule (for Duplicate Files)

Rules for this screen are:

l Rule name is mandatory.

l In “Include directories” text field, set single or multiple directories separated by commas.

l Enter a value in the “Limit Rows” field, to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule may return a very large number of rows; if no value is entered, then
all data is returned. Limit Rows fetches the Top “n” largest from the total result set.

l The description is optional.

l When you select OK, the rule is created based upon the selected check boxes.

Edit Rule (for Duplicate Files)

With the Edit Rule screen, you edit the rule by changing the Rule Criteria and description, as shown in
the following representative screen display.
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Figure 20 Edit Rule (for Duplicate Files)

The Rule Name is disabled so that you cannot change the rule name for any report. Also, Radio
buttons for “Apply this rule to” are disabled so that you cannot change the rule type (Files, Duplicate
Files, Directories). The remaining criteria to enter is the same as described previously to create a rule
for duplicate files.

Deleting Rules
To delete rules, use the screen displayed with the Report Rules tab. The following shows a
representative screen display.

Figure 21 Delete Rules
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You can select theDelete button to delete multiple rules (those with checked boxes next to the rule
name), or you can delete individual rules using the Delete icon for the specific rule.

The result from removing (deleting) rules depends upon whether or not the rule is mapped to a volume,
and whether the data has been collected for that rule. The following summarizes the conditions and
effects:

l If you remove a rule that is not mapped to a volume, the rule is deleted directly.

l If you remove a rule that is mapped to a volume, AND the data is not collected, the system
deletes both the rule AND themapping data.

l If you remove a rule that is mapped to a volume, AND the data is collected, the system deletes
the rule, themapped data, and also the collected data (report).

l When you select theClear Now button, the system clears the data related to the rule.

Viewing Results in Report Tree
When the system gathers data for a volume, it checks to see if any rules aremapped to that volume.
If rules aremapped to that volume, the system collects the data according to the parameters defined
in the rule, then stores this information in the data tables. The collected information can then be
viewed from the Reporter tree (Reporter > System > File Server).

Sometimes the File System Viewer report datamight not be visible immediately after the rule
executes because the reports cache has not yet been updated. To refresh the File System Viewer-
related report cache data, select theRefresh FSRM Reports Cache Now button. The button is on
the Custom Reports tab screen, and is located next to theAdd andDelete buttons in the upper right
part of the screen.

Enabling the Collection of Access Control Entry Data
Collection
for Directories on Windows Servers
Access Control Entries for directories can be collected onWindows file servers running 6.0 or later
CIM Extensions. Youmust enable the collection of Access Control Entry Data to view information in
the Trustee view.

To enable the collection of Access Control Entry Data, follow these steps:

1. Change the global property, fileSrm.collectACL, from false to true:

a. Click Configuration > Product Health.

b. Select Advanced from the Disk Space tree.

c. Change the value of fileSrm.collectACL from false to true by pasting the following in the
Custom Properties field:

fileSrm.collectACL=true

d. Click Save.
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e. Restart the service for HP Storage Essentials, AppStorManager.

2. Select the Collect ACL option for a scan of a volume on aWindows server:

a. Click Configuration > File System Viewer.

b. On the File Server tab, selectWindows in the Select OS Typemenu, and then click Filter.

c. Click Add Schedule.

d. In the top pane, select the storage volumes you want to add, and then click Add.

e. In the lower pane, select the Collect ACL option. You can select the option for specific
volumes or for all of the volumes at once. The following figure shows the Collect ACL option
being selected for all of the volumes on a file server by selecting the option in the heading.

Figure 22 Selecting the Collect ACL Option for all of the Volumes on a File Server

3. Click OK.

4. Select Scan Now.

HP Storage Essentials starts gathering ACL data. To view the ACL data for all of your file
servers, access the Trustee view, as described in Trustee View on page 78.

When the collection option is enabled, the file scan process collects each directory’s Discretionary
ACL information, governed by the following considerations:

l The process collects only the information allowed by the access rules and ignores the information
denied by the access rules.

l The process considers allowing access based upon all the related rules, whether directly
assigned on the directory or whether they are inherited from one of the parent directories.

l The trustees corresponding to theWell Known SIDs as defined by Microsoft
(http://Support.microsoft.com/kb/243330) are excluded from being listed in the output.
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l The effective permissions for each trustee are designated as “Full Access,” “Write Access,” or
“Read Access.”

n Write Access is the combination of the rights – List Directory, Traverse Directory, Add File,
Add Subdirectory, Write Directory, Traverse Directory, Read Attributes, and Read
Permissions.

n Read Access is a combination of rights – List Directory, Traverse Directory, Read
Attributes, and Read Permissions.

n Full Access is the combination of rights as defined by “Full Control by Windows.”

l Data Collection treatment is similar for both individual users and groups, that is, groups are not
drilled down to get a list of individual users.

l The collection attempts to get the name of the various security entries from the corresponding
security ID (SID). However, the name resolution from the SID may fail if the SID is from a
different host or domain from the file server through which the file system is being scanned. In
such cases, the SID itself would be listed as the trustee, instead of the name.

The collected data is sent to a file on the disk along with other scan data files. Then, the data file
created by the process is transferred to themanagement server along with other scan files. On the
management server, the data is parsed to extract the effective usage by each trustee.

Note: The process can have a performance impact during the scan. If the Access Control
Lists are extracted, the scan times can be larger than they would be otherwise.

About the FileSRMProvider.properties File
The FileSRMProvider.properties file resides in the conf directory of installed CIM Extensions. It
contains the following properties:

l com.appiq.fsrm.dataDir – Defines the directory in which FSRM data and log files are written.
The default is the <CIM EXTN root>/xData directory. If there is an error with the directory
specified, then the default directory will be used. When you change the property, youmust restart
the CIM extension for the new value to take effect.

l com.appiq.fsrm.chunkSize – Defines the chunk size (in KB) used to transfer FSRM data to the
management server. Typically, it does not needmodification by the user.

l com.appiq.fsrm.StatusPollInterval – Defines how often (in seconds) themanagement server
retrieves the state of the current scan from the native FSRM process. The default interval is 60
seconds. Note that increasing the frequency of status polling (decreasing the polling interval)
may increase the length of time required by the scan.

Defining UNC Volumes
You can use UNC shares to discover file system data from a server. If you want to scan UNC
volumes, youmust define them in aUncShares.xml file. To create theUncShares.xml file on a
Windows host, follow these steps:

1. Confirm that a CIM extension is installed on theWindows host.
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2. Go to the <Installation_Directory>\CimExtensions\conf directory.

3. Open theUncShares.xml-sample file in a text editor.

4. Identify the host through which the UNC shares’ scan is planned. This is the host through which
you will be scanning UNC shares from a different/remote host.

5. Add the host name and shared directory to the following line:

<!-- <UNC_SHARE PATH=""/> -->

Here is an example:

<UNC_SHARE PATH="\\RemoteSystem\MyShare1"/>

In this instance, RemoteSystem is the name of the host andMyShare is the name of the shared
directory.

Repeat it for all of your shares; for example:

<UNC_SHARE PATH="\\RemoteSystem\MyShare1"/>

<UNC_SHARE PATH="\\RemoteSystem\MyShare2"/>

<UNC_SHARE PATH="\\RemoteSystem\MyShare3"/>

6. Save the file as UncShares.xml.

7. Restart the CIM Extension service on themanaged host.

8. Update the element details for the host from themanagement server by running aGet Details.

9. Edit the File System Viewer configuration page for the host selecting the desired UNC shares to
scan.

The username and password combination you used for discovering the host should have at least
read only permissions on the file shares which need to be scanned. So inmost cases this would
be a service account which you can have created in the active directory. This service account
should be an admin on the “proxy FSV host” and should have read only (at least) access to the
UNC share

Note: You can use the IP address of the host instead of the name.

With management server versions earlier than 6.0, if you want to discover multiple UNC shares
which have different credentials, youmust use different “proxy FSV hosts”. This is because for
these earlier versions, you can use only use one login / password pair (each UNC share has its
own associated login / password).

For management server version 6.0 and later, this restriction does not exist. For these later
management server versions, you can specify different credentials for each UNC Share or
volume by using theCredentials option.
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2 Viewing File System Information Across
the Enterprise
Use File System Viewer to obtained detailed information about the file servers enterprise wide, a
specific file server or volumes.

File System Viewer displays information from file servers in views, which are accessible by clicking

File System Viewer ( ) in the left pane and then setting a context, as described in Setting a
Context below.

Note: File servers and their hosts must be in the same organization for File System Viewer to
work properly.

This chapter describes the following information:

l Setting a Context below

l Saving a View on next page

l Dashboard Information for the Enterprise on page 49

l Properties of the File Servers on page 51

l Extension View on page 52

l Providing Expressions for the Filter Fields on page 52

l Viewing Extension Groups on page 53

l Aging View for the Enterprise Context on page 54

l Sizes View for the Enterprise Context on page 55

l Managing Users on a File Server on page 57

l Policies for a User on page 64

l Viewing Security and User Identifiers for All File Servers on page 67

l Trustee View on page 69

l Scan Status on page 72

l Scan Schedule on page 72

l Viewing Attribute Details on page 73

Setting a Context
Note: If you do not see any file servers listed, verify that you have set up File System Viewer,
as described in Setting up File System Viewer on page 10.
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Use the Set Context feature in File System Viewer to specify which elements you want File System
Viewer to scan.

To set a context for File System Viewer.

1. Select one of the following:

n Enterprise. All file servers or elements are included in the scan.

n File Server. All file servers, selected file servers or only one file server is selected in the
scan.

n Volume. All volumes, selected volumes or only one volume is selected in the scan.

2. If you selected:

Enterprise, go to Click Go. File System Viewer scans the specified elements and provides the
information in the lower half of the page. below.

File Server, follow these steps in order:

a. Select all or one of the operating systems from the Select OS Typemenu.

b. (Optional) Enter all or part of a file servers name in the Filter by File Server Name field. Wild
cards (*) are accepted. For example, if you want to scan all file servers that begin with
California, you would enter the following: California*

c. Select file servers from the Select File Server field.

Volume, follow these steps in order:

a. a) Select all or one of the operating systems from the Select OS Typemenu.

b. b) Enter all or part of a file servers name in the Filter by VolumeName field. Wild cards (*) are
accepted. For example, if you want to scan all volumes that begin with Sacramento, you
would enter the following: Sacramento*

c. c) Select file servers from the Select Volume field.

3. Click Go. File System Viewer scans the specified elements and provides the information in the
lower half of the page.

If you want to reset the context to Enterprise, click theReset button.

4. Select the view you want.

Individual File Server Details on page 75 provides information about the views for a file server.
Individual VolumeDetails on page 97 provides information about the views for a volume.

Saving a View
File System Viewer lets you save a view, so you can quickly access the information again without
selecting a context.
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For example, assume you have a volume that periodically fills up with data. Youmay want to save
the Sizes view for a volume so you can quickly access the view again to determine if the space is
being taken up by several very large files or many small files.

To save a view.

1. Select a context as described in Setting a Context on page 47.

2. Select a view.

3. Click Save View.

4. Provide a name for the view.

If you are saving the name of a view that includes information about a file server or volume,
include the name of the file server and/or volume as well as the name of the view.

File System Viewer saves the view in theMy Views table, as shown in the following figure:

Figure 23 Saving Views

Wait for the current page to complete loading before clicking a saved view in theMy Views table;
otherwise, youmay see an error when you click a saved view.

Dashboard Information for the Enterprise
The dashboard page of themanagement server provides an overview of the status of all file servers in
your network. The dashboard provides the following four panes:

Note: As the file sizes grow, the units switch frommegabytes to gigabytes.

l Summary. The summary pane displays the following items:

n A graph displaying the top five file servers by scanned space.

n A table listing:

n Number of file servers

n Volumes
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n Scanned space inmegabytes

n Users - The number of users

n Users space - The amount of space inmegabytes that is being consumed.

If you want to see a full-page view, access the File Servers view for the Enterprise context, as
described in Properties of the File Servers on the facing page.

l Top ten extensions by size. The pane displays the top 10 file extensions that take up themost
space in gigabytes. If you want to see a full-page view, access Extensions view for the
Enterprise context, as described in Extension View on page 52.

l Aging. The pane displays in gigabytes the size of files that have beenmodified or used within the
following periods:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l Sizing. The pane displays the number of files modified within the following period:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years
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For example, if two 3-GB files weremodified within the last 30 to 60 days, two would be
displayed for the 30-60 day label.

To access the dashboard:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

The Enterprise option tells File System Viewer to scan for all file servers on the network.

3. Select Dashboard from the Select View menu.

4. Click Go.

The four panes are displayed.

Tip: To refresh data in a pane, click theRefresh button ( ) in the upper-left corner of the
pane.

Properties of the File Servers
The File Servers view provides the same information as the Summary pane in the dashboard, in
addition to a table that lists all the file servers and their properties.

You can view the following information when you select the File Servers view for an Enterprise
context:

l A graph displaying the top five file servers by scanned space.

l A table listing:

n Number of file servers

n Volumes

n Scanned space inmegabytes

n Users - The number of users

n Users space - The amount of space that is being consumed.

l A table displaying the following information for each of the file servers:

n Volumes

n Scanned space

n Number of users

n Amount of space the number of users

Note: As the file sizes grow, the units switch frommegabytes to gigabytes.

To access information about file servers:

1. Click File System Viewer ( ) in the left pane.
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2. Select Enterprise from the Select Context menu.

3. Select File Servers from the Select View menu.

Extension View
The Extensions view for the Enterprise context provides the following information for file extensions:

l A graph displaying the top 10 file extensions by:

n Usage – Total size of all the files with the particular extension.

n Count – Number of files with the particular extension.

l A table displaying the following information for each file extension:

n Usage – Total size of all the files with the particular extension.

n Count – Number of files with the particular extension.

To filter the information for one or more file servers, provide the name of the file extension or
provide an expression in the Filter field and then click Submit. For more information about
expressions, see Providing Expressions for the Filter Fields below.

To view information about extension groups, select Extension Group from the Filter menu or
provide an expression. Youmust create extension groups before seeing any information, see
Viewing Extension Groups on the facing page and Creating Extension Groups on the facing page.

Note: Data less than 1 MB is not displayed in the charts. This could result in an empty chart if
all data points are less than 1 MB.

To access the Extension view for the Enterprise context, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

Providing Expressions for the Filter Fields
File System Viewer provides filter fields throughout the various windows. Use expressions such as
the wildcard (*) to narrow your view to a particular set of items.

All of the filters work the same. For example, even though the following examples are for file
extensions, the same expressions would work for any other item you want to filter, such as file
servers.

l d* returns all extensions starting with d

l *d returns all extensions ending with d

l *d* returns all extensions having d in the extension
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Viewing Extension Groups
Create extension groups to determine how groups of file extensions are being used. For example,
assume you want to understand how much space graphic files are using and how often they are being
used. You could create a discovery group that contains file extensions for graphic files, such as gif,
png, and jpg.

Once you have created your extension groups, you can view the following information about your
extension groups:

l A graph displaying the top 10 file extension groups by:

n Usage – Total size of all the files with the particular extension.

n Count – Number of files with the particular extension.

l A table displaying the following information for each extension group:

n Extensions – File extensions that make up the extension group.

n Usage – Total size of all the files with the particular extension.

n Count – Number of files with the particular extension.

To display a reduced set of information, provide the name of the extension group or an expression
in the Filter field and then click Submit. For more information about providing expressions in the
Filter field, see Providing Expressions for the Filter Fields on previous page.

Note: Data less than 1 MB is not displayed in the charts. This could result in an empty chart if
all data points are less than 1 MB.

Creating Extension Groups
To create an extension group, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

4. Select Extension Group from the Filter menu.

5. Click New Extension Group.

6. Enter a name for the extension group in theExtension Group Name field; for example, Graphic
files.

7. Enter the extensions you want to be included in the group in the Extensions field. Separate each
file extension with a comma. For example, assume you want the discovery group to track file
extensions for gif, png, and jpg files, you would enter the following in the Extensions field:

gif, png, and jpg

8. Click Finish.
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Editing Extension Groups
To edit a discovery group, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

4. Select Extension Group from the Filter menu.

5. Click Edit ( ) for the extension group you want to edit.

6. Modify which extensions you want to belong to the group in the Extensions field.

7. Click Finish.

Deleting Extension Groups
To delete an extension group, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

4. Select Extension Group from the Filter menu.

5. Click Delete ( ) for the extension group you want to remove.

Aging View for the Enterprise Context
The Aging view provides the following information about the file servers in your environment

Note: As the file sizes grow, the units switch frommegabytes to gigabytes.

l A graph displaying the size of files that have beenmodified or used within the following time
periods:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years
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n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l A table displaying the number of files and their size that have been accessed, modified, and
created in the specified time periods, which are the same as those listed in the graph. To view
this table, click the plus sign (+) to the left of the Show/Hide Aggregated Summary Details text.

l A table displaying by file server the number of files and their size in megabytes that have been
created, modified or accessed within the specified time period. To determine which type of
information you want displayed in the table, select Accessed,Modified orCreated from the Age
Distribution since last menu. Then click Submit.

To access the Aging view, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Aging from the Select View menu.

The Aging view is displayed.

Sizes View for the Enterprise Context
The Sizes view can help you understand if space on a server is being taken up by a few very large
files that are never used.

The Sizes view displays the following information:

l A graph displaying the distribution of files by usage or by count within the following size groups:

n 0 Bytes

n 0-10 KB

n 10-100 KB

n 100 KB-1 MB

n 1 10MB

n 10-100MB

n 100+ MB

l A table displaying by file server the number of files and their size that fall within the specified size
groups.

Note: As the file sizes grow, the units switch frommegabytes to gigabytes.

To access the Sizes view, follow these steps:

55



Chapter 2

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Sizes from the Select View menu.

The Size view is displayed.

To view additional information about the files within a size group, click one of the size groups in
the graph, as shown in the following figure.

Figure 24 Clicking a Size Group for More Information

The following are displayed:

n A pie chart showing the sizes of the files with the size group on each server.

n A pie chart showing the number of files with the size group on each server.

n A table showing the number of files with the size group on each server and the amount of
space they occupy.

Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if
all the data points are less than 1 MB.

4. To view more information about the size group on a volume, click a file server in the File Server
column in the table.

The following are displayed:

n A pie chart showing the sizes of the files with the size group on each volume

n A pie chart showing the number of files with the size group on each volume

n A table showing the number of files with the size group on each volume, the amount of space
they occupy, and the collection time.
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Managing Users on a File Server
Properties of Users
The Users tab displays the properties of the user accounts assigned to file servers.

To access the properties, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

Note: The user account names displayed on this page are obtained by the followingmethods:

n Themanagement server scanning the file servers.

n Information imported through LDAP servers. For more information about importing users
through LDAP, see Importing User Information from LDAP and Active Directory Servers on
page 26.

n Users created through the Create User tool in File System Viewer. For more information
about creating users in File System Viewer, see Adding File System Viewer Users on next
page.

The page displays the following:

l A graph showing the top five users by usage and the amount of space they use.

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored.

n Users Size – The amount of space the users use.

n Largest User – The user who uses themost space.

n Largest User Size – The amount of space the largest user uses.

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user

n Home Directory – The home directory of the user. The home directory is assigned to a user
by the user’s organization. By default, the user has full access rights (read, write, execute) to
the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.

n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

57



Chapter 2

n *User Status – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n *Manager – The name of the user’s manager.

n Quota – The amount of space the user is allocated.

n Used – The amount of space the user is using.

n Instances – The number of file servers on which the user's home directory is present.

*The User Status andManager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild car, enter the full name in the Filter
box, and then click Submit.

Viewing Details for a File System Viewer User
You can view detailed information about a File System Viewer user, such as the following:

l Department

l Quota

l Total Used by Owners

l Total Used by Directories

To view details of a File System Viewer user, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Under the User ID column, click the link for the user you want to know more about.

You are shown detailed information about the user, such as the following:

n Which volumes and file servers the user is taking up space and the amount.

n Any policies assigned to the user.

Adding File System Viewer Users
File System Viewer provides data about users on the file servers. For example, the software provides
information such as:

l The amount of space the users are using

l The user who is using themost amount of space and the amount of space being used

It obtains information about its users from the file scans of the servers. You can also provide user
information through this tool.
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This tool simulates the creation of a user account. To obtain information about users, youmust first
add them in File System Viewer. These users differ from the users for themanagement server. When
you add a File System Viewer user, you aremaking File System Viewer aware of that user for
monitoring. That user is not granted access to themanagement server.

To add a File System Viewer user, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click theNew User button located under the graph.

5. In the ID box, enter the user ID.

6. In the Name box, enter the name for the user.

Provide the domain name for users on servers runningWindows, for example,
mydomain\username. The domain name is case sensitive.

7. In the Directories box, specify a user's home directory. Home directories are assigned to users
by their organization. A user can havemultiple, comma-separated home directories.

Note: Directory paths are case sensitive andmust be fully qualified paths. Map a user’s usage to
the home directory when configuring a file server scan.

8. In the Owners box, enter the owners that are associated with the user. Separatemultiple owners
with a comma. The owner names should be similar to what the OS reports. For example, the
domain\username onWindows.

Note: It is required that information be entered into either the Directories box or the Owners box,
but not both. Entering information into both boxes is accepted, but not required.

9. In theDepartment Nomenu, select a department number corresponding to the department to
which the user belongs. The department number was assigned to the department when the
department was added by using Chargeback Manager

10. In the E-mail box, enter the user’s e-mail address.

11. In the Quota box, enter themaximum amount in megabytes the user can use.

Note: Entering 0 in the Quota box grants unlimited storage capacity to the selected user.

12. Click OK.

Modifying File System Viewer Users
You canmodify the following properties for a File System Viewer:

l Name

l Directories

l Owners
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l Department Number

l E-mail

l Quota

Note: These steps modify a File System Viewer user, not a user account for themanagement
server.

Tomodify one or more of these properties for a user, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. In the table below the graphic, click theEdit ( ) button corresponding to the user you want to
modify.

5. Modify one or more of the properties listed at the beginning of this section.

6. Click OK.

The File System Viewer user is updated.

Deleting File System Viewer Users
These steps modify a File System Viewer user, not a user account for themanagement server. They
do not impact access to themanagement server nor to the file server.

To delete a File System Viewer user, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Do one of the following steps:

n To delete one user at a time, click theDelete ( ) button corresponding to the user you want
to remove. When you are asked if you want to delete the user, click OK.

Or

n To deletemultiple users at once, select the users in the far left column and click theDelete
button located above the table. When you are asked if you want to delete the users, click
OK.
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Exporting a List of Users
After you add your users, export the list of users in case you need to reinstall themanagement server.
The user list is saved as a comma-separated values file, which can be opened in a text editor, such
as Notepad. You can add to the comma separated list as described inModifying a List of Users
below.

To export the list of users, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click Export Users.

5. When you are asked if you want to save the comma-separated values file, click Save, and then
designate a location to save the file.

Modifying a List of Users
After you export a list of users, you can easily add to it. The attributes for each user appear on a row
for that user. The format of a user’s record is as follows:

<User ID>,<User Name>,<Home Directory(s)>,<Department>,

<E- Mail>,<Quota><Owner(s)>

Assume you have a user with the following attributes:

l User ID – JS

l User Name – John Smith

l Home Directory – Program Files

l Department – Engineering

l E-Mail – jsmith@companyname.com

l Quota – 500

l Owner – jsmith

The information for the user would appear as follows in the list:

JS,John Smith,\Program

Files,Engineering,jsmith@companyname.com,500,jsmith

A list with multiple users would appear as follows:

JS,John Smith,\Program

Files,Engineering,jsmith@companyname.com,500,jsmith

JD,John Doe,\Program Files,Engineering,jdoe@companyname.com,500,jdoe
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DD,David Double,\Program Files,Engineering,jdouble@companyname.com,

500,ddouble

The record for a user with multiple home directories would appear as follows:

JS,John Smith,”\jsmith,\home\jsmith”,Engineering,

jsmith@companyname.com,500

The record for a user with multiple owners would appear as follows:

Adm,A-

dministrator,,,netadmin@mycompany.com,,”root,bin,adm,uucp,nobody,

Administrator”

Note: The owner can be omitted if the home directory is provided, and the home directory can
be omitted if the owner is provided.

The following boxes must be valid. Failure of any of these conditions causes themanagement server
to log that record as an error and continue to the next record:

l <User ID>

l <HomeDirectory> or <Owner>

l Optional: <Department> – If you provide a department, the department must exist on the
management server. The department can be empty.

l Optional: <Quota>

l Optional: <E-Mail>

Box Condition

User ID Required box. Cannot include the following:

More than 64 characters

Single quote (')

Double quote (“)

Forward slash (/)

Back slash (\)

User Name Required box. Cannot includemore than 64 characters.

Table 2 Restrictions for User Boxes
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Box Condition

Home
Directory

Required if the owner is not specified.

List of one or more directories separated by commas, with each directory name not
more than 4000 characters.

Individual directory names should not contain commas.

Department Null or an existing department.

E-Mail Null or a string of up to 253 characters.

Quota
(Megabytes)

Null or 0 to indicate unlimited, or a rational decimal number less than
9999999999999.

Value is in MBs.

Owner Required if the home directory is not specified.

List of one or more owner names separated by commas, with each individual owner
name not exceeding 256 characters.

Individual owner names should not contain commas.

Viewing Detailed Information for a User
To view detailed information for a user, such as the amount of space being used on a volume, follow
these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click theOwners tab.

The following information is displayed for the user:

n File server name

n Volume name

n Size used

n Owner
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Importing a List of Users
You can import a list of users from a comma-separated values file. For information on how to add to
the current list of users in File SRM, see Exporting a List of Users on page 61 andModifying a List of
Users on page 61.

Themanagement server provides two ways to import a list of users:

l Full Import – Replaces all current users in the list with the users in the import file.

l Partial Import – Updates existing users and adds new users.

To import a list of users, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click Import Users.

5. Click Browse to select the list of users you want import.

6. Select Full Import orPartial Import.

7. Click OK.

When you perform a partial or full import, you are provided with a report with the following information:

l Number of records read

l Number of users created

l Number of users updated

l Number of users that could not be created

l Format errors

l Directory and owner both unspecified

l Directory already mapped to a user

l Owner already mapped to a user

l Invalid departments

l Multiple entries for users

Policies for a User
To view the policies for a user, follow these steps:

1. Click File System Viewer ( ) in the left pane.
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2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

File System Viewer displays the policies assigned to the user.

The features displayed on this page are also shown in Policy Manager, which is a tool in HP Storage
Essentials that is used for generating policies.

Policy Manager can automatically send an e-mail, generate an event, or run a custom script when the
file server is being overused. For example, you can configure Policy Manager so you receive an email
message when the amount of free space on a file server decreases to a specified level.

l Add Policies

l Edit Policies

l Test Policies

l Delete Policies

Adding Policies
Top-level information is provided in this section about policies. For more information, see the
Managing Policies chapter in the User Guide.

To add the policies for a user:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Click Add in the right corner.

7. In the Name box on the Policy Properties tab, enter a name for the policy or keep the default.

8. In the Description box, modify the description for the policy or keep the default.

9. In the Re-arm Period box, specify the amount of time (in minutes) after the policy executes
before it can execute again. The re-arm period is useful for limiting the number of times the same
actions will execute.

Note: Specify shorter periods for important applications.

10. In the Conditionmenu, specify a comparison operator.
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11. To the right of the Comparison Operator menu, take the following action, depending on the box
displayed:

n Enter a percentage.

n Enter an amount in gigabytes (GB).

n Type the number of available media that will trigger an alert.

12. For trending policies, enter the number of days in the Historic period box
(7 to 180 days) and Projection period box (min=1; max=180). The Historic period is the number of
days in the past that meet the condition.

13. For trending policies, enter the number of days in the future that wouldmeet the condition in the
Projection period box (1 day to 360 days).

14. Select an action to occur when the policy condition is fulfilled. For more information, see “Actions
Available forWhen a Policy Condition is Fulfilled” in the User Guide.

15. Click Finish.

Editing Policies
Top-level information is provided in this section about policies. For more information, see the
Managing Policies chapter in the User Guide.

To edit a policy, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Click theEdit ( ) button corresponding to the policy you want to modify.

7. In the Name box, change the name for the policy.

8. In the Description box, change the description for the policy.

9. Select or deselect theActive option to activate or de-activate the policy.

10. In the Re-arm Period box, specify the amount of time (in minutes) after the policy executes
before it can execute again. The re-arm period is useful for limiting the number of times the same
actions will execute.

Note: Specify shorter periods for important applications.

11. In the Conditionmenu, change the conditions of the policy.

12. For trending policies, change the number of days in the Historic period box (min=7; max=180) or
Projection period box (min=1; max=180).
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13. Select an action to occur when the policy condition is fulfilled. For more information, see “Actions
Available forWhen a Policy Condition is Fulfilled” in the User Guide.

14. Click OK.

Testing Policies
To test a policy, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Click the Test button for the policy.

Deleting Policies
To delete a policy, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

4. Click aUser ID in the User ID column.

5. Click thePolicies tab.

6. Perform one of the following actions:

n Delete a policy – To delete just one policy, click theDelete ( ) button corresponding to the
policy you want to delete.

Or

n Delete several policies at once – To delete several policies at one time, select the check
boxes next to the policies you want to delete. To select all of the policies, select the check
box next to theName heading, and click theDelete ( ) button.

The policies are deleted.

Viewing Security and User Identifiers for All File Servers
You can get owner-related details by accessing the Ownership tab. This tab also lets you determine
how many files this owner is using on the file server.
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Note: TheOwnership tab is disabled by default for file servers running onMicrosoft Windows.
To view theOwnership tab, set the fileSrm.collectWindowsSID property to true as described
in Enabling the Ownership Tab onWindows on the facing page, or you can select the Collect
Ownership Information checkbox when configuring a file server scan.

To access the Ownership tab, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Ownership from the Select View menu.

The following are displayed:

n A graph showing the top 10 owners, who use themost in megabytes.

n A table displaying the following:

n Ownership – The security identifier (Windows) or user identifier (UNIX).

n Files – The files that the security identifier or user identifier uses.

n Size – The total size of the files the security identifier or user identifier uses.

4. To filter by owner or by expression, enter the information in the Filter field, and click Submit. For
more information about filtering by expressions, see Providing Expressions for the Filter Fields
on page 52.

Viewing Detailed Information About an Owner
To view detailed information, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Ownership from the Select View menu.

4. To learnmore about an owner, click the owner’s name.

The following are displayed:

n A pie chart showing the sizes of the files with the owner on each server.

n A pie chart showing the number of files with the owner on each server.

n A table showing the number of files with the owner on each server and the amount of space
they occupy.

Note: Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if
all the data points are less than 1 MB.
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Enabling the Ownership Tab on Windows
TheOwnership tab is disabled by default for file servers running onMicrosoft Windows. To view the
Ownership tab, youmust set the fileSrm.collectWindowsSID property to true.

To set the fileSrm.collectWindowsSID property to true, follow these steps:

1. Select Configuration > Product Health, and then click Advanced in the Disk Space tree.

2. Click Show Default Properties at the bottom of the page.

3. Copy the fileSrm.collectWindowsSID property. How you copy the text depends on yourWeb
browser. If you are usingMicrosoft Explorer or Netscape Navigator, select the text, and then
right-click the selected text, and then select Copy.

4. Return to the Advanced page (Configuration > Product Health, and then click Advanced in
the Disk Space tree).

5. Paste the copied text into the Custom Properties box. How you paste the text depends on your
Web browser. If you are usingMicrosoft Explorer or Netscape Navigator, right-click the box, and
select Paste.

6. Make your changes in the Custom Properties box.

7. Change the value assigned to the fileSrm.collectWindowsSID property to true.

fileSrm.collectWindowsSID=true

8. When you are done, click Save.

9. Restart the AppStorManager service for your changes to take effect.

Trustee View
If you do not see information in the Trustee View, make sure you have enabled ACL data collection,
as described in Enabling the Collection of Access Control Entry Data Collection for Directories on
Windows Servers on page 43.

The Trustee view provides the following:

l A graph listing the top 10 trustees by size.

l A table listing the following for each trustee:

n Size

n Directories

To access the Trustee view, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Trustee from the Select View menu.
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To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
Providing Expressions for the Filter Fields on page 52.

For information about viewing detailed trustee data, see Viewing Detailed Trustee Data below.

Viewing Detailed Trustee Data
To view detailed information for a trustee, click the name of a trustee in the Trustee view. You are
then shown two pie charts:

l Size associated with the trustee in megabytes.

l Number of directories associated with the trustees.

Below the pie charts is a table listing the size in megabytes and directories for each file server
associated with the trustee. An example of the pie charts is shown in the following figure:

Figure 25 Selected Trustee Drill-down at Enterprise Level

The following shows a display of Selected Trustee Drill-down at the file server level.
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Figure 26 Selected Trustee Drill-down at File Server Level

To obtained evenmore detailed information about the directories associated with the trustee, click
one of the pie charts or a file server listed in the table.

A table is provided with the following information for each directory associated with the trustee:

l Size of the current directory in megabytes

l Size of the current directory including subdirectories

l Number of trustees

l Trustee’s share

l Attributes – See Viewing Attribute Details on page 73 for more information about themeaning
behind the letters.

l Permissions – The letters in the Permissions column have the followingmeaning:

n R – Read

n W –Write

n F – Full

How Data is Calculated in the Trustee View
On themanagement server, the data is parsed to extract the effective usage by each trustee. This is
calculated by the summation of effective usage by the trustee on each directory has permission to
access. The following shows how the effective space calculations are determined for the statistics
shown in the example.
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Directory Name Full Size Own Size Trustee Rights

A 10GB 8GB X

Y

Z

F

R

–

B 18GB 12GB X

Y

Z

–

F

W

C 14GB 6GB X

Y

Z

F

F

F

Table 3 Directory Statistics

The following is the effective space calculation:

l X: From A + From B + From C = (8/2) + 0 + (6/3) = 6GB

l Y: From A + From B + From C = (8/2) + (12/2) + (6/3) = 12GB

l X: From A + From B + From C = 0 + (12/2) + (6/3) = 8GB

The “own” size of a directory is considered for calculation and not the full size (which includes the size
of its subdirectories), because the subdirectories are being calculated separately anyway.

User interface screens are available to display the ACL information at various levels, including the
Enterprise level (all file servers), a selected file server, and a Volume level, for all the trustees. In
addition, drill-down is available for selected trustees at various levels.

Scan Status
The Scan Status view displays detailed information from the scans. This information is also available
from the Scan Status tab, which is accessed by selectingConfiguration > File System Viewer. For
detailed information about scan status information, see Scan Status Tab on page 25.

Scan Schedule
The Scan Schedule view displays the scheduled scans. This information is also displayed in the
Scheduled Scan tab accessible from theConfiguration > File System Viewermenu. For more
detailed information about scan schedules, see Schedule for Multiple File Servers (Multiple Scans) on
page 20.
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Viewing Attribute Details
In several of the views, attribute information is provided as a letter or several letters in the Attribute
column. The attributes have the followingmeaning:

Letter Detail

R ReadOnly

H Hidden

S System

D Directory

A Archive

V Device

N Normal

T Temporary

P Sparse File

J Reparse Point

C Compressed

O Offline

I Not Content Indexed

E Encrypted
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3 Individual File Server Details
This chapter describes the following:

l Dashboard Information for a File Server below

l Properties for a File Server on page 77

l Finding VolumeDetails on page 78

l Types of Files on a File Server on page 79

l Aging Properties of Files on a File Server on page 82

l Size Group Distribution Information on page 83

l Users for a File Server on page 84

l Ownership Information for a File Server on page 85

l Trustee Information for a File Server on page 86

l Events for a File Server on page 86

l Topology for a File Server on page 94

l Scan Status for File Servers on page 95

l Scan Schedule for File Servers on page 96

Dashboard Information for a File Server
The dashboard displays the following information for file servers.

l Summary

n A graph displaying the top five volumes by usage on the file server. The amounts for free
space and used space are displayed. Data less than 1 MB is not displayed in the graph. This
could result in an empty graph if all data points are less than 1 MB.

n A summary table to the right of the graph displaying the following:

n Volumes – Number of volumes on the file server.

n Capacity – Size of all volumes on the file server.

n Used – Amount of used space on all volumes on the file server.

n Free – Amount of free space on all volumes on the file server.

n Used Percent – Amount of used space on all volumes on the file server.

n Free Percent – Amount of free space on all volumes on the file server.

n Users – Number of users assigned to one or more of the volumes on the file server.

n Users Space – Amount of space the users use on the file server.
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To see a full-page view, access the Volumes view for the file server context, as described in
Finding VolumeDetails on page 78.

l Top ten extensions by size displays the top 10 file extensions that take up themost space in
gigabytes.

l Aging displays the (gigabyte) size of files modified or used within the following periods:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l Sizing displays the number of files modified within the following period:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, two would be
displayed for the 30-60 day label.

To access the dashboard, follow these steps:

1. Click File System Viewer ( ) in the left pane.
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2. Select a file server, as described in Setting a Context on page 47.

3. Select Dashboard from the Select View menu.

4. Click Go.

To refresh data in a pane, click theRefresh button ( ) in the upper-left corner of the pane.

Properties for a File Server
To view the properties for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select Properties from the Select View menu.

The Properties page displays the following information.

l Business Cost – Used to determine the cost impact of the application on the network. The
currency displayed is dependent upon the standards and formats setting on themanagement
server. In the Business Cost field, type an amount, for example 35.25. Then click OK.

l Custom Name – A unique name for the file server. The custom name is displayed for the File
System Viewer application instead of the file server's default name. The unique name helps in
distinguishing this File System Viewer instance from the actual server. To create a unique name,
type the name in the Custom Name field, and then click theSave button.

l *Vendor – The vendor that created the file server.

n You cannot enter a symbol in front of the number, except for the dollar sign ($).

n You can enter a number with decimal points, such as 30.50.

l *Contacted – The last time the software contacted the file server.

l *Record Created –When a record was created for the file server.

l *Discovery Status – The status of the last discovery. If the element was just discovered, the
status is at “created.”

l Install Date –When the file server was installed.

l *Name Detected – The name of the file server detected.

l OID – TheObject Identifier

l *Description – Provides information about the type of element. In this instance, it would display
FileServer.

l *Target Operating System – The operating system of the file server.

l IdentificationCode – The identification code of the file server.

l *Product Name – The product name of the file server.
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l Serial Number – The serial number of the file server.

l Build Number – The build number of the file sever.

l Version – The version number of the file server.

l *Host – The name of the host

l Business Cost (per hour) – The business cost that was set at the top of this page.

*These fields are populated. The rest of the fields are blank by default.

To update the data by doing aGet Details, click Update Element Data. Get Details may take awhile.

Finding Volume Details
To view the properties of the volumes on a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select Volumes from the Select View menu.

Note: You can view additional information on volumes that have had file server collection. See
Finding VolumeDetails above for more information.

This page displays the following:

l A graph displaying the top five volumes by usage on the file server. The amounts for free space
and used space are displayed.

Data less than 1 MB is not displayed in the graph. This could result in an empty graph if all data
points are less than 1 MB.

l A summary table to the right of the graph displaying the following:

n Volumes – The number of volumes on the file server.

n Capacity – The size of all volumes on the file server.

n Used – The amount of used space on all volumes on the file server.

n Free – The amount of free space on all volumes on the file server.

n Used Percent – The amount of used space on all volumes on the file server.

n Free Percent – The amount of free space on all volumes on the file server.

n Users – The number of users assigned to one or more of the volumes on the file server.

n Users Space – The amount of space the users use on the file server.

l A table below the graph displaying the volumes and the following properties:

n Capacity – The size of the volume.

n Used – The amount of space that is used on that volume.
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n Used% – The percentage used on the volume.

n Users – The number of users assigned to that volume.

n Users Space – The amount of space the users use.

Types of Files on a File Server
The Extensions view provides information about the types of files on a file server. For example, it can
let you know how many mpgs are stored on a file server and their file size. In the extensions tab, there
is a drop-downmenu to select Extension Groups, in which files are grouped by file type.

To view information about file extensions on a server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select Extensions from the Select View menu.

You see the following:

n A graph displaying the top 10 extensions and their size.

n A table below the graph displaying the extension and its following properties:

n Size – The size of all the files with that extension. This property lets you see which
types of files are using themost space on a file server.

n Count – The number of files with this extension.

4. To filter by extension, enter the extension name and click theSubmit button. See Providing
Expressions for the Filter Fields on page 52 for more information.

5. Click an extension in the Extension column in the table.

The following is displayed:

n A pie chart showing the sizes of the files with the extension per volume.

n A pie chart showing the number of files with the extension per volume.

n A table showing the number of files with the extension per volume and the amount of space
they occupy.

Data less than 1MB is not displayed in the graph. This could result in an empty graph if all data
points are less than 1MB.

6. To view a listing of the files with the extension on the volume, click a volume in the Volume
column in the table. The largest N andmost aged N files with the extension are listed in the tabs
“Largest Files” and “Aged Files.” The filenamewith path, size, and the accessed, modified, and
created time are provided.
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7. You can save the extensions for a volume in a comma-separated list by clicking theSave
Extension Detail button in the right pane. The extensions for that volume are saved in a comma-
separated list (CSV file).

Note: If you attempt to view the CSV file in Microsoft Excel, keep inmind that Excel can only
handle a limited number of records. If the file won’t open in Excel, it may be necessary to bring
the CSV file into a database. Another option is to break the CSV file into smaller pieces that
Excel will be able to handle.

Extension Groups

The following shows a representative display of the Extensions tab selected, and the drop-down
menu choices for selecting Extension Groups.

Figure 27 Extensions Group Drop-Down Menu

Select Extension Groups to display a screen showing the extension groups along with the
extensions. A screen similar to the following displays.
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Figure 28 Groupings for Extension Groups

You can edit or delete extension groups using the Edit or Delete icons. To create a new extension
group, select theNew Extension Group button, and a screen similar to the following displays.

Figure 29 Create Extension Group Screen Display
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You can enter the new extension group name and the extensions separated by commas. After
extension groups are created, extension group detail information will appear in the Extensions tab
when the extension group is selected from the drop-downmenu.

From the volume level extension groups chart page, you can go to an intermediate page before a final
drill-down page. The intermediate page lists constituent extensions with hyperlinks to the drill-down
page to that specific extension. The following shows a representative display of the screen.

The display lists constituent extensions with hyperlinks to the drill-down page for that specific
extension.

Filtering Files

Filters use the following expressions:

l d* returns all extensions starting with d

l *d returns all extensions ending with d

l *d* returns all extensions having d in the extension

You can enter a list of extensions separated by a comma.

Aging Properties of Files on a File Server
To find information about the aging properties of the files on a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select theAging view in the right pane.

4. To save the aging details to a comma-separated list (CSV file):

By default the page displays the following information:

l A graph displaying in gigabytes the size of files that have beenmodified or used within the
following time periods:

n 0-30 days
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n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l A table displaying the number of files and their size in megabytes that have been accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph. To view this table, click the plus sign (+) to the left of the Show/Hide Aggregated
Summary Details text.

l A table displaying by volume the number of files and their size in megabytes that have been
created, modified or accessed within the specified time period. To determine which type of
information you want displayed in the table, select Accessed, Modified or Created from the
Age Distribution since last menu. Then click Submit.

Size Group Distribution Information
To view size information for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select theSizes view.

The page displays the following:

n A bar chart displaying the size group distribution by usage or by count depending on the
option selected.

n Usage. It is the total size of all the files with the particular extension.

n Count. It is the number of files with the particular extension.

n A table listing the number of files and the total size for each size group on each volume.

4. To obtain more detailed information about a size group, click its corresponding heading in the
table:

The following is displayed:
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n A pie chart showing the sizes of the files with the size group per server.

n A pie chart showing the number of files with the size group per server.

n A table showing the number of files with the size group per server and the amount of space
they occupy.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all the
data points are less than 1 MB.

5. To view a listing of the oldest files with the size group on the volume, click a volume in the Drive
column in the table.

Note: You can save the files with the size group for a volume in a comma-separated list (CSV
file) by clickingExport Files to CVS.

Users for a File Server
To view user information for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the followingmethods:

l Themanagement server scanning the file servers.

l Information imported through LDAP servers. For more information about importing users through
LDAP, see Importing User Information from LDAP and Active Directory Servers on page 26.

l Users created through the Create User tool in File System Viewer. For more information about
creating users in File System Viewer, see Adding File System Viewer Users on page 58.

The page displays the following:

l A graph showing the top five users by usage and the amount of space they use.

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored.

n Users Size – The amount of space the users use.

n Largest User – The user who uses themost space.

n Largest User Size – The amount of space the largest user uses.

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user
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n Home Directory – The home directory of the user. The home directory is assigned to a user
by the user’s organization. By default, the user has full access rights (read, write, execute) to
the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.

n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

n *User Status – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n *Manager – The name of the user’s manager.

n Quota – The amount of space the user is allocated.

n Used – The amount of space the user is using.

n Instances – The number of file servers on which the user's home directory is present.

*The User Status andManager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild card, enter the full name in the
Filter box, and then click Submit. See Providing Expressions for the Filter Fields on page 52 for more
information.

Ownership Information for a File Server
To view ownership information for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select Ownership from the Select View menu.

The following is displayed for the file server:

n A graph showing the top 10 owners, who use themost in megabytes.

n A table displaying the following:

n Ownership – The security identifier (Windows) or user identifier (UNIX).

n Size – The total size of the files the security identifier or user identifier uses.

n Files – The files that the security identifier or user identifier uses.

4. To filter by owner or by expression, enter the information in the Filter field, and click Submit. For
more information about filtering by expressions, see Providing Expressions for the Filter Fields
on page 52.
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Trustee Information for a File Server
If you do not see information in the Trustee View, make sure you have enabled ACL data collection,
as described in Enabling the Collection of Access Control Entry Data Collection for Directories on
Windows Servers on page 43.

The Trustee view provides the following:

l A graph listing the top 10 trustees by size.

l A table listing the following for each trustee:

n Size

n Directories

To access the Trustee view, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select Trustee from the Select View menu.

To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
Providing Expressions for the Filter Fields on page 52.

For information about viewing detailed trustee data, see Viewing Detailed Trustee Data on page
70. For information about how the trustee data is collected, see How Data is Calculated in the
Trustee View on page 71.

Events for a File Server
The Events view lists the events that involve the file server. It provides the following information
about the events for a file server.

To access the Events tab, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select theEvents view in the right pane.

Note: Events listed on this pagemay not be attributed to the correct source until Getting
Details has completed.

Setting up a Filter
Themanagement server provides several types of event filters which lets you specify which events
you want Event Manager to display.
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You can use all the event filters at once or you can use just one of them. You can filter events by:

l Time period

l Severity level

l Element type

l Summary text

l Element name

l Cleared status

l Specific element

To set up a filter, follow these steps:

1. Click the Filter heading at the top of the page:

The following filtering feature is displayed:

2. Select a time from the Time Period combo box. You can also select a customized time as
described in Selecting a Custom Time Period on page 89.

3. Select which events of a severity type you want displayed. Use the Control and Shift keys to
select multiple severities. The following options are provided:

n All – Events of all severities are displayed.
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n Unknown –Only events of the severity type, unknown, are displayed.

n Informational –Only events of the severity type, informational, are displayed.

n Warning –Only events of the severity type, warning, are displayed.

n Minor –Only events of the severity type, minor, are displayed.

n Major –Only events of the severity type, major, are displayed.

n Critical –Only events of the severity type, critical, are displayed.

4. Select which events of an element type you want displayed. Use the Control and Shift keys to
select multiple severities. The following options are provided:

n All

n Application

n Host

n Switch

n Storage System

n Tape Library

n Fabric

n Other

n HP Storage Essentials

5. To set the filter by summary text, enter the text you want to be used for the filter in theSummary
Text Contains field.

Youmay want to use this option when you are seeing several events that span over several
elements or severity levels.

For example, if you want to determine if someone else is logging into themanagement server as
admin, you can find how often the admin user has logged into themanagement server over the
last few days by entering the following text in theSummary Text Contains field:

User admin logged in

6. To set the filter by element name enter text in theElement Name Contains field.

This feature can be helpful if you are interested in events from elements that have similar names.

For example, let’s assume you have a naming convention for hosts, where all hosts that belong
to the engineering group begin with engineering. Event Manager could display only events from
those hosts by entering engineering in theElement Name Contains field.

7. To set a filter by cleared status, select one or more of the following by using the Control and Shift
keys.

n All – All events regardless of their clear status

n All But Clear – All events except for thosemarked clear
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n Clear –Only events marked clear

8. Tomerge all events together, select Collapse all events with same severity, type and
element.

This feature is very useful when numerous events of the same severity, type and element are
being picked up by themanagement server. If you select the optionCollapse all events with
same severity, type and element, themanagement server displays just unique events with a
total count in front of them, rather than list all of the events individually.

9. To have Event Manager filter elements automatically at a set interval, select theAutomatically
filter every option and select one of the following:

n 30 seconds

n 1minute

n 5minutes

n 10minutes

10. When you are done setting your options, click the Filter button.

Note: You can update the events displayed by clicking the Filter button.

Selecting a Custom Time Period
Note: Youmay want to select a custom time period for the filter when troubleshooting an
issue.

To select a custom time period:

1. Select theCustom Time Period option.

2. Event Manager only displays events that occur after the start date and time and before the end
date and time:

a. Click the Calendar icon to the right of theStart Date field:

b. In the Calendar, select the start date:
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c. In the Time field, enter the start time.

The time is based on a 24-hour clock. For example, to have Event Manager display events
occurring after 8 p.m. on the specified date, enter 20:00.

d. When you are done setting the start time and date, click Set.

3. To set the end date and time for the filter. Event Manager only displays events that occur after
the start date and time and before the end date and time:

a. Click the Calendar icon to the right of theEnd Date field.

b. In the Calendar, select the end date:

c. In the Time field, enter the end time.

The time is based on a 24-hour clock. For example, if you want Event Manager to display
events occurring before 8 p.m. on the specified date, you would enter 20:00.
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d. When you are done setting the end time and date, click Set.

Resetting a Filter
To revert to the default settings for the filter, follow these steps:

1. To access the filter for Event Manager, click the Filter heading at the top of the page:

The filtering feature is displayed:

2. Click theReset button.

The filter is reset.

Setting up Advanced Filtering
Event Manager has an advanced filtering feature that lets you provide detailed information for filtering.

To set up advanced filtering, follow these steps:

1. To access the filter for Event Manager, click the Filter heading at the top of the page:

The filtering feature is displayed:
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2. Expand theAdvanced Options heading, as shown in the following figure:

Once the AdvancedOptions heading has been expanded, the Element NameContains field
becomes inactive. Any values entered in the Element NameContains field are ignored as long as
the AdvancedOptions heading is expanded.

3. Click theAdd button:

4. Select the element type you want to add and then click Next.

5. Select one or more elements you want to add to the filter and then click Next.

Only the elements of the type you specified in the previous window are displayed.

For example, if you selected hosts in the previous window, only hosts are displayed in this
screen.

If the element you are looking for does not appear on the first page of the table, use the navigation
tools at the top of the table to page through the list of elements.

The hosts you select are listed in the navigation filter.

For example, in the following figure Host_13081 and Host_10380 were selected for advanced
filtering, so they are listed under the Advanced Filtering heading:
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6. Verify that Advanced Options heading is expanded as shown in the following figure. Advanced
Optionsmust be expanded for advanced filtering to work.

7. Click the Filter button.

Event Manager displays the elements specified under Advanced Options.

Clearing Advance Filtering Options
You can clear the filtering set for advanced options, by clicking theClear Data button under the
AdvancedOptions heading.

Viewing Event Details
To access event details, click the link for the event under the Summary Text column. You can also
right-click an event and select Event Details from the drop downmenu.
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The Event Details pane provides information on one or more of the following:

l Serial Number – The number assigned to the event

l Summary Text – A brief explanation of the event

l Element – It is the source of the event. An element can be a switch, host, application, fabric or
anything else on the network. If this field is blank, the event did not come from an element.

l Source – If the event came from an element, the name of the element is provided.

l Time Reported – The time the event was reported to themanagement server.

l Probable Cause – Provides an explanation of a probable cause.

l Recommended Actions – Provides recommendations.

l Event Type – Provides a description of the event.

l Correlated Indications – Information obtained from the provider.

l Severity – Provides the severity level, which can be one of the following:

n Clear

n Unknown

n Informational

n Warning

n Minor

n Major

n Critical

Sorting Events
To sort events, click the column title corresponding to the attribute you want to sort the event. For
example, if you want to sort events by time, click the Time heading on the table on the Events tab.
The events are sorted by time on the Events page.

Topology for a File Server
To view the topology for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select the Topology view in the right pane.

The topology is displayed for the file server:
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Scan Status for File Servers
The Scan Status view displays detailed information from the scans for a file server. This information
is also available from the Scan Status tab, which is accessed by selectingConfiguration > File
System Viewer. You will also see information for other file servers. For detailed information about
scan status information, see Scan Status Tab on page 25.

To view the scan status for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select theScan Status view.
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Scan Schedule for File Servers
The Scan Schedule view displays the scheduled scans for a file server. This information is also
displayed in the Scheduled Scan tab accessible from theConfiguration > File System Viewer
menu; however, you will also see information for other file servers as well. For more detailed
information about scan schedules, see Schedule for Multiple File Servers (Multiple Scans) on page
20.

To view the scan status for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a file server, as described in Setting a Context on page 47.

3. Select theScan schedule view.
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This chapter describes the following:

l Dashboard Information for a Volume below

l Properties for a Volume on page 99

l File System Details for a Volume on page 100

l Extensions on Volumes on page 102

l Aging Information for a Volume on page 103

l File Sizes on a Volume on page 105

l Users on a Volume on page 106

l Ownership Information for a Volume on page 107

l Trustee Information for a Volume on page 107

l Scan Status for Volumes on page 108

l The Explorer View on page 108

l Directory Dashboard Details on a Volume on page 109

Dashboard Information for a Volume
The dashboard displays the following information for volumes.

l Summary

n A graph represented in one of the following ways:

n If all large directories are less than 1 MB, the pie chart has only two sectors, Free and
Used.

n If there are several large directories with a size larger than 1 MB, the pie chart has one
sector for Free, eight sectors for the top eight directories, and one last sector for Used
(Rest).

n A summary table to the right of the graph displaying the following:

n Total Storage – The capacity of the volume.

n Used – The amount of used space on the volume.

n Free – The amount of free space on the volume.

n Scanned Space – The total size of the files that are scanned by File System Viewer.

n Capacity – The size of the volume.

n Used % – The percentage of used space on the volume.
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n Free% –The percentage of free space on the volume.

n File System – Type of the file system on the volume.

n Number of Files – Total number of files on the volume.

n Number of Directories – Total number of file on the volume.

To see a full-page view, access the File System Info view for the volume context, as described in
File System Details for a Volume on page 100.

l Top ten extensions by size displays the top 10 file extensions that take up themost space in
gigabytes. To see a full-page view, access Extensions view for the Enterprise context, as
described in Extensions on Volumes on page 102.

l Aging displays the (gigabyte) size of files modified or used within the following periods:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ year

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l Sizing displays the number of files modified within the following period:

n 0-30 days

n 30-60 days

n 60-90 days

n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years
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n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, two would be
displayed for the 30-60 day label.

To access the dashboard, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Dashboard from the Select View menu.

4. Click Go.

To refresh data in a pane, click theRefresh button ( ) in the upper-left corner of the pane.

Properties for a Volume
To view the properties for a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Properties from the Select View menu.

The Properties page displays the following about the volume:

l *Contacted – The last time the software contacted the file server.

l *File System Type – The type of file system on the volume, such as New Technology File
System (NTFS).

l *Block Size

l *Discovery Status – The status of the last discovery. If the element was just discovered, the
status is at “created.”

l Consumable Blocks

l *Number of Blocks

l *Remote Storage

l *Record Created –When a record was created for the file server.

l *Device ID

l *Total Space

l Data Organization

l *Description

l Access
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l *Host – The name of the host

l Business Cost (per hour) – The business cost that was set at the top of this page.

l *Disk Drives – The drive(s) associated with the volume.

l *Disk Partitions – Partitions on the volume.

*These fields are populated. The rest of the fields are blank by default.

File System Details for a Volume
To view the properties of the volumes on a file server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select File System Info from the Select View menu.

This page displays the following:

l A graph represented in one of the following ways:

n If all large directories are less than 1 MB, the pie chart will have only two sectors, Free and
Used.

n If there are several large directories with a size larger than 1 MB, the pie chart will have one
sector for Free, eight sectors for the top eight directories, and one last sector for Used
(Rest).

l A summary table to the right of the graph displaying the following:

n Total Storage – The capacity of the volume.

n Used – The amount of used space on the volume.

n Free – The amount of free space on the volume.

n Scanned Space – The total size of the files that are scanned by File System Viewer.

n Capacity – The size of the volume.

n Used % – The percentage of used space on the volume.

n Free% –The percentage of free space on the volume.

n File System – Type of the file system on the volume.

n Number of Files – Total number of files on the volume.

n Number of Directories – Total number of file on the volume.

l Below the chart, there are three tabs which provide the following:
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n Largest Directories – This table lists the largest directories on the volume first. File System
Viewer provides the following for each directory: the size of the directory, number of files in
the directory, and number of sub directories in the directory. The information in this table
consists only of the files and directories directly contained in the directory in question and not
those in the sub directories. Click the hyperlink on the directory name to display a summary
snapshot of the directory where the Aging, Extension, Size, Largest Files, and Aged Files
information is presented in respective tabs.

n Largest Files – This table provides lists the directories with the largest files on the volume
first. File System Viewer displays the name of the file, its size, and the accessed, modified,
and created time.

n Aged Files – This table provides information about the age of the directories with on the
volume. It displays the following information about the volume:

n Name of the file

n Its size

n Owner

n Last accessed

n Last modified

n Created

n Attributes, as described in Viewing Attribute Details on page 73.

n Largest Temp Files – Displays the largest temporary directories. File System Viewer
provides the following information:

n Name of the file

n Its size

n Owner

n Last accessed

n Last modified

n Created

n Attributes, as described in Viewing Attribute Details on page 73.

T he time and date the file was last accessed. If information is displayed in the table, either
the Extension group TEMP does not exist orFile System Viewer could not find any temporary
files. If no TEMP extension group found, create the extension group with the name TEMP
andmap all temporary file extensions to get the list of largest temp files.

n Duplicate Files – Displays duplicate file data.File System Viewer provides the following
information:

n Name of the file

n Its size
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n Owner

n Last accessed

n Last modified

n Created

n Attributes, as described in Viewing Attribute Details on page 73.

If no duplicate file data is found for the volume, one of themay have occurred:

n No rule was created

n A volume not mapped to the duplicate report rule

n No duplicate files exists.

Extensions on Volumes
The Extensions view provides information about the types of files on a volume. For example, it can let
you know how many mpgs are stored on a file volume and their file size. In the extensions tab, there
is a drop-downmenu to select Extension Groups, in which files are grouped by file type.

To view information about file extensions on a server, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Extensions from the Select View menu.

You see the following:

n A graph displaying the top 10 extensions and their size. Data less than 1MB is not displayed
in the graph. This could result in an empty graph if all data points are less than 1MB.

n A table below the graph displaying the extension and its following properties:

n Size – The size of all the files with that extension. This property lets you see which
types of files are using themost space on a volume.

n Count – The number of files with this extension.

4. To filter by extension, enter the extension name and click theSubmit button. See Providing
Expressions for the Filter Fields on page 52 for more information.

5. If you want to view the extension groups for a volume, select theExtension Group filter. See
Viewing Extension Groups on page 53 for more information about creating, viewing, and
removing extension groups.

6. To view a listing of the files with the extension on the volume, click a volume in the Volume
column in the table. The largest N andmost aged N files with the extension are listed in the tabs
“Largest Files” and “Aged Files.” The filenamewith path, size, and the accessed, modified, and
created time are provided.
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Extensions at the File Level
To view extensions at the file level, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Extensions from the Select View menu.

4. Click an extension in the table.

File System Viewer displays Largest Files and Aged Files tabs, which provide the following
information:

n File name

n Size

n Owner

n Last accessed

n Last modified

n Created

n Attributes – See Providing Expressions for the Filter Fields on page 52.

5. To export the information to a comma, separated list, click Export files to CSV.

Note: If you attempt to view the CSV file in Microsoft Excel, keep inmind that Excel can only
handle a limited number of records. If the file won’t open in Excel, it may be necessary to bring
the CSV file into a database. Another option is to break the CSV file into smaller pieces that
Excel will be able to handle.

Aging Information for a Volume
To view aging information for a volume, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select theAging view in the right pane.

By default the page displays the following information:

l A graph displaying in gigabytes the size of files that have beenmodified or used within the
following time periods:

n 0-30 days

n 30-60 days

n 60-90 days
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n 90-180 days

n 180 days-1 year

n 1-2 years

n 2-3 years

n 3-4 years

n 4-5 years

n 5+ years

For example, if two 3-GB files weremodified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

l A table displaying the number of files and their size in megabytes that have been accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph. To view this table, click the plus sign (+) to the left of the Show/Hide Aggregated
Summary Details text.

l A table displaying by volume the number of files and their size in megabytes that have been
created, modified or accessed within the specified time period. To determine which type of
information you want displayed in the table, select Accessed, Modified or Created from the
Age Distribution since last menu. Then click Submit.

Aging Properties for Individual Files
To view aging properties for individual files, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select theAging view in the right pane.

4. Click the heading of an age group in the table.

You are shown a table listing the following information for the files in the age group:

n Size

n Owner

n Last accessed

n Last modified

n Created

n Attributes. See Viewing Attribute Details on page 73 for more information.

5. To save the aging details to a comma-separated list (CSV file), click Export files to CSV.
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File Sizes on a Volume
To view information about file sizes on a volume, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select theSizes view in the right pane.

The page displays the following:

n A bar chart displaying the size group distribution by usage or by count depending on the
option selected.

n Usage. It is the total size of all the files with the particular extension.

n Count. It is the number of files with the particular extension.

n A table listing the number of files and the total size for each size group on each volume.

Individual File Sizes
To view detailed information about individual file sizes on a volume, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select theSizes view in the right pane.

4. To obtain more detailed information about a size group, click its corresponding heading in the
table:

A table is displayed showing the following information about each file in the size group:

n Size

n Owner

n Last accessed

n Last modified

n Created

n Attributes. See Viewing Attribute Details on page 73 for more information.

Note: Data less than 1MB is not displayed in the graphs. This could result in an empty graph if
all the data points are less than 1 MB.

5. To save the details to a comma-separated list (CSV file), click Export files to CSV.
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Users on a Volume
To view information about users on a volume, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the followingmethods:

l Themanagement server scanning the file servers.

l Information imported through LDAP servers. For more information about importing users through
LDAP, see Importing User Information from LDAP and Active Directory Servers on page 26.

l Users created through the Create User tool in File System Viewer. For more information about
creating users in File System Viewer, see Adding File System Viewer Users on page 58.

The page displays the following:

l A graph showing the top five users by usage and the amount of space they use.

l A summary table to the right of the graph displaying the following:

n Users – The number of users assigned to all of the file servers monitored.

n Users Size – The amount of space the users use.

n Largest User – The user who uses themost space.

n Largest User Size – The amount of space the largest user uses.

l A table below the graph displaying the users and the following properties:

n User ID – The ID of the user

n User Name – The name of the user

n Home Directory – The home directory of the user. The home directory is assigned to a user
by the user’s organization. By default, the user has full access rights (read, write, execute) to
the home directory. A user can havemultiple home directories.

n Owner – The owners who are associated with the user. A user can havemultiple owners.

n Department Number – The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

n *User Status – The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

n *Manager – The name of the user’s manager.

n Quota – The amount of space the user is allocated.

n Used – The amount of space the user is using.
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*The User Status andManager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild cars, enter the full name in the
Filter box, and then click Submit. For more information, see Providing Expressions for the Filter
Fields on page 52.

Ownership Information for a Volume
To view ownership information for a volume, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Ownership from the Select View menu.

The following is displayed for the file server:

n A graph showing the top 10 owners, who use themost in megabytes.

n A table displaying the following:

n Ownership – The security identifier (Windows) or user identifier (UNIX).

n Size – The total size of the files the security identifier or user identifier uses.

n Files – The files that the security identifier or user identifier uses.

4. To filter by owner or by expression, enter the information in the Filter field, and click Submit. For
more information about filtering by expressions, see Providing Expressions for the Filter Fields
on page 52.

Trustee Information for a Volume
The Trustee view provides the following:

l A graph listing the top 10 trustees by size.

l A table listing the following for each trustee:

n Size

n Directories

To access the Trustee view, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Trustee from the Select View menu.
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To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
Providing Expressions for the Filter Fields on page 52.

For information about viewing detailed trustee data, see Viewing Detailed Trustee Data on page
70. For information about how the trustee data is collected, see How Data is Calculated in the
Trustee View on page 71.

Scan Status for Volumes
The Scan Status view displays detailed information from the scans for a volume. This information is
also available from the Scan Status tab, which is accessed by selectingConfiguration > File
System Viewer. You will also see information at the level of the file server. For detailed information
about scan status information, see Scan Status Tab on page 25.

The Explorer View
The Explorer view provides the following information:

l A table providing the following information about the directories on the volume:

n Current directory information:

n Size of the current directory in megabytes

n Number of directories in the current directory

n Number of files in the current directory

n Current directory and subdirectories information:

n Size of the current directory and its subdirectories in megabytes.

n Number of directories in the current directory and its subdirectories in megabytes.

n Number of files in the current directory and its subdirectories in megabytes.

n When the current directory was created.

n When the current directory was modified.

n When the current directory was last accessed.

n Attributes of the current directory. See Viewing Attribute Details on page 73 for more
information about attributes.

l A table listing the files that are at the top-level of the current directory and the following
information about them:

n Size inmegabytes.

n Owner.

n When the file was created.
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n When the file was last modified.

n When the file was last accessed.

n Attributes of the file. See Viewing Attribute Details on page 73 for more information about
attributes

Note: OnWindows, the file owner listed for an encrypted file will be the account running the
CIM extension service (usually the host's local administrator account).

To view the directory’s files and subdirectories, click the name of the directory in the first table:

To access the Explorer view, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.

3. Select Explorer from the Select View menu.

Directory Dashboard Details on a Volume
To view directory dashboard details, follow these steps:

1. Click File System Viewer ( ) in the left pane.

2. Select a volume, as described in Setting a Context on page 47.
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3. Select Explorer from the Select View menu.

4. Click theDirectory Dashboard Details link located above the first table.

File System Viewer provides the following detailed information at your fingertips in the directory
dashboard details page for files.

The Directory Dashboard provides the directory size and the number of files in the directory. This
information can be found under the name of the directory:

When you access the Directory Dashboard, you are shown the following tabs:

l Aging – A table displaying the number of files and their size in megabytes that have been
accessed, modified, and created in the specified time periods, which are the same as those listed
in the graph.

l Extensions – A table displaying the extension and its following properties:

n Size – The size of all the files with that extension. This property lets you see which types of
files are using themost space on a volume.

n Count – The number of files with this extension.

l Sizes – A table listing the number of files and the total size for each size group on each volume.

l Aged Files – A table listing the following properties of a file:

n Size

n Owner

n When the file was last accessed

n When the file was last modified

n When the file was created

n Attributes. See Viewing Attribute Details on page 73 for more information.

Files are listed by age with the oldest files displayed first.

l Largest Files – A table listing the following properties of a file:

n Size

n Owner

n When the file was last accessed

n When the file was last modified
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n When the file was created

n Attributes. See Viewing Attribute Details on page 73 for more information.

Files are listed by size with the largest files displayed first.

l Trustee – A table listing the following for each trustee:

n Trustee’s Share

n Permissions
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